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OpenSSD Introduction



OpenSSD Motivation

Need a SSD platform
- to develop a new firmware algorithm

- to explore hardware architecture
and organization

Use a commercial product as a platform?

- little information on HW/SW

- no way to change controller SoC
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What'’s the OpenSSD Project?

Open source SSD design used for research and education

Host Interface Firmware

S_SD Flash Translation Layer
Firmware

Low-Level Driver

NAND Riasn Bus / DMAC ARM Processor
Controller
Host Interface . Performance

SSD
Controller
Hardware

Software
Development

Hardware
Developrment

HANYANG 4<%83)z

UNIVERSITY '
ENC Lab 4

Embedded Network Computing Lab.



OpenSSD Project History

m Open-source SSD platforms
Jasmine OpenSSD (2011)
Cosmos OpenSSD (2014)
Cosmos+ OpenSSD (2016)

m Cosmos/Cosmos+ OpenSSD: FPGA-based platform
Could modify SSD controller and firmware
Could add new hardware and software functionality



Why OpenSSD

m Realistic research platform
Solve your problem in a real system running host applications
Design your own SSD controller (hardware and firmware), if possible

m Information exchange
Share your solution with people in society

m Community contribution
Open your own solution to public

m EXxpensive custom-made storage system
Unique

m Play for fun
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1st OpenSSD (Indilinx)

m Jasmine OpenSSD (2011)
SSD controller: Indilinx Barefoot (SoC w/SATA2)
Firmware: SKKU VLDB Lab
Users from 10+ countries

Barefoot
Controller
SoC

NAND Flash
Memory
(32GB/module)

SATA-2

Interface
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2"d OpenSSD (Hanyang University)

m Cosmos OpenSSD (2014)
« SSD controller: HYU Tiger 3 (FPGA w/PCle Gen2)
« Firmware: HYU ENC Lab
« Users from 5 countries (mostly in USA)

SSD
Controller
in FPGA

NAND Flash Module

(128 GB)

External PCIe
Interface
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3rd OpenSSD (Hanyang University)

m Cosmos+ OpenSSD (2016)

» SSD controller: HYU Tiger 4 (FPGA w/NVMe over PCle Gen2)
» Same main board with different memory modules

» Firmware: HYU ENC Lab

» Users from ?? countries

o EXPRESS)

NAND Flash Modules
(1 TB/module)

Same platform with
Cosmos OpenSSD
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Platform Comparison

Jasmine OpenSSD Cosmos OpenSSD Cosmos+ OpenSSD
Released in 2011 2014 2016
Main Board
SSD Controller Indilinx Barefoot (SoC) HYU Tiger3 (FPGA) HYU Tigerd (FPGA)
PCle Gen2 4-lane PCle Gen2 8-lane
Host Interface SATA2 (AHCI) (NVMe)
Maximum Capacity 128 GB (32 GB/module) 256 GB (128 GB/module) 2 TB (1 TB/module)
NAND Data Interface SDR (Asynchronous) NVDDR (Synchronous) NVDDR2 (Toggle)
ECC Type and Strength BCH, 16 bits/512 B BCH, 32 bits/2 KB BCH, 26 bits/512 B

HANYANG
UNIVERSITY
ENGLab . 10



OpenSSD Project Homepage

é =

B a ’ 5 The OpenssD Project X | EEN

O o (@ www.openssd.io

HOME PUBLICATIONS

IT'S OPEN-SOURCE

All materials including documents, firmwares,
hardware RTL sources, and platform board

schematics are fully accessible to the public.

RESOURCES FORUM

PEnSSD

OPEN-SOURCE SOLID-STATE DRIVE PROJECT FOR RESEARCH AND EDUCATION

PEOPLE RELATED LINKS

http://www.openssd.io

IT'S MODULAR

All software and hardware designs consist of
many replaceable modules and offer flexibility

in their re-design.

IT'S REAL

Areal hardware board, called Cosmos OpenSSD
platform, is a part of Cosmos OpenSSD system.

It operates as a real solid-state drive.

HANYANG
UNIV

NIVERSITY

Embedded Network Computing Lab.

11



Cosmos+ OpenSSD Overview

Process |
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Cosmos+ OpenSSD Environment

m 1 Development PC
Downloading hardware/software design (JTAG)
Monitoring Cosmos+ OpenSSD internals (UART)

®m 1 HostPC
Executing applications such as a benchmark (PCle)

m 1 Platform board with 1+ NAND flash modules installed
Working as a storage device to the host PC

Hardware and software
binary files

JTAG |

I SSD Controller ~
) NVMe over PCle >
UART
B |
Internal ] AVI
information NAND FElash [ PDF | [ mP3 |
Module
Development PC Host PC

Platform board
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Hardware Components

m Cosmos+ OpenSSD platform board
» Consists of a Zynq FPGA and other peripherals

m NAND flash modules

» Configured as multi-channel and multi-way flash array
» Inserted into Cosmos+ OpenSSD platform board

m External PCle adapter and cable
» Connected with host PC

m USB cables for JTAG and UART
» Connected with development PC

m Power cable and adapter
« 12V supply voltage

HANYANG
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Cosmos+ OpenSSD Platform Board

SD card
connector
~

QSPI memory
\ Configuration mode SW

< 13

User-configurable LED

55 mm

power connector
6-pin PCle
power connector

Board
Ethernet power SW
PMbus
JTAG digilent connector
module
ac
= >
...... 3 3
USB to UART TN
USB 2.0 ULTP 2
SMA connector =
Fan connector
JTAG select SW -7 &8 R | [ o | i
20pin  7&L4pin { 12CPMOD | PMOD  20pin S4
Y 4 . .
JTAG  JTAG / ; pin || pin  ARM JTAG User-configurable SW
HANYANG User-configurable VCCO_ADJ VCCO_ADJ
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Primary Details

FPGA Xilinx Zyng-7000 AP SoC (XC72045-FFG900-3)
Logic cells 350K (~ 5.2M ASIC gates)
Type Dual-Core ARM Cortex™- A9
CPU
Clock frequency Up to 1000 MHz
Total capacity Upto 2 TB (MLC)
Storage
Organization Up to 8-channel 8-way
Device interface DDR3 1066
DRAM
Total capacity 1GB
System AXI-Lite (bus width: 32 bits)
Bus
Storage data AXI (bus width: 64 bits, burst length: 16)

SRAM

256 KB (FPGA internal)

HANYANG
UNIVERSITY
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Zyng-7000 FPGA Architecture

m Xilinx’s embedded SoC

/ Hardwired Application Processor Unit
- component
m Two regions
. Programmable ARM Cortex-A9 ARM Cortex-A9
» Processing System (PS) " component
- Hardwired components
. LUni
- Executes the firmware program I Snoop Control Unt |
: i : OCM L2 Cache & Cache
° Programmable LOglC (PL) 2;2::;15'”9 < (Uig_lr?l}gglsm) Interconnect Controller
- Programmable components (PS) x %
(FPGA region)
- NAND flash controller (NFC) and Y v
NVMe controller reside in PL
Programmable
c 0 P .| Memory Interface N Logic to
. . entral Interconnect "| (DDR3 Controller) | Memory
. BenefItS Of USlng Zynq Interconnect
» CPU is more faster than soft core > v v+ % £ £ %
(such as MicroBlaze) GPAXI || GPAXI
Master Slave HP AXI Slave ports
« No need to worry about ports ports
organizing hardware memory Programmabl% vy v 414 1 1 4 4
controller, and some other Logic (PL)
peripherals (such as UART) User Defined FPGA Logic
« Xilinx supports BSP (Board \_

Support Package)

Zyng-7000 architecture overview
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Cosmos OpenSSD NAND Module

m Each module has 4 flash packages

One flash package

- Capacity: 32 GB

- Page size: 8640 Bytes (spare area: 448 Bytes)
Synchronous NAND

m Used with Tiger3 Controller

Flash package

-~ HYU_ENC-LAB

Front side Rear side

HANYANG
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Logical Organization of Flash module

Module configuration
4 channels/module and 4 ways/channel

Shared signals within a channel (a package)
Dies in the same package share the I/O channel
Dies in the same package share command signals except Chip Enable (CE)
Each die has own Ready/Busy (R/B) signal

Channel 3
Package 3
Channel 2
Package 2
Channel 1
Package 1
Package 0 Channel 0

CEO, R/BO
Die 0 e
CE1, R/BL
Die 1 Warl
_— ] EZRﬁz
| Die 2 e
CE3, R/B3
Die 3 Wars

HANYANG
UNIVERSITY



Cosmos+ OpenSSD NAND Module

m Each module has 8 flash packages
» One flash package
- Capacity: 128 GB
- Page size: 18048 Bytes (spare area: 1664 Bytes)
» Toggle NAND

m Used with Tiger4 Controller

C o RINNENERIRTINNNAN

Flash package : [ | l ¥ ] [ [1 ’ ! ' [ l l [] l‘ Flash package

~.=.‘ ~ A
NN‘

uuuuu

lIIIlIlllIlIlIIIIIIIIIIIIIIIIIIIIIII IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
Front side Rear side
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Logical Organization of NAND Flash Module \Y

Module configuration
4-channels/module and 8-ways/channel

Shared signals within a channel (a package)
Dies in the same package share the I/O channel
Dies in the same package share command signals except Chip Enable (CE)
Each die has own Ready/Busy (R/B) signal

W Package 3 Channel 3
Package 6 | Package 2 1 Channel 2
Package 4 _ Package 0 Channel 0
Die 0 CE4, R/B4 - CEO, R/BO
_\Nayél Dle 0 WayO
CE5, R/B5 p— -
Die 1 Ways Die 1 C:a?fl
e - CE6, R/B6 T o
_ Die? M| L Die2 H——
- CE7, R/B7 - CE3. R/B3
Dle 3 Way7_ — D|e 3 Way3
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NAND Module Setup \

m Cosmos OpenSSD
Supports only one flash module slot (J1)

m Cosmos+ OpenSSD
Supports both flash module slots (J1, J2)

SO-DIMM (J2) SO-DIMM (J1)

m Caution
Cosmos/Cosmos+ OpenSSD flash module slots have custom pin maps
You should not insert any SDRAM module into this slot

HANYANG
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External PCle

m Expand PCle Slot of host PC to connect external device

m Adapter card
Installed on host PC
Provide a high-performance and low latency solution for expanding PCle

m External PCle cable (8-lane)

m External PCle connector (8-lane) on platform board
2.5 GT/s for a Genl, 5.0 GT/s for a Gen2
Connected with high data rate serial transceiver in FPGA

External PCle adapter External PCle cable
HANYANG
UNIVERSITY
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Connection with Development PC

m JTAG cable
Used for downloading hardware and software binary files

Available cable types
- USB type A to USB type micro B cable
- Emulator, JTAG N pin cable (N: 7, 14, 20)

m UART cable

Used for monitoring internal processes of Cosmos+ OpenSSD
USB type A to USB type A cable

USB emulator

USB cable for
emulator

7pin cable

USB type A

USB type micro B

cable
ﬁN’W! RASII\ITGY Available JTAG cables
Lab

Embedded Network Computing Lab.

USB type A l

UART cable
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Power Connection ‘v\?‘\

m Single-source of power to the platform board
6-pin power connector (J181) or 5.5mm X 2.1mm DC power plug (J182)

LT
-
~-~-~~
— ey

6-pin power

5.5mm X 2.1Tmm DC power

m The 6-pin connector looks similar to the regular PC 6-pin PCle connector
Note: Difference in pin assignment between two connectors

Pin map
Connector
1 2 3 4 5 6
Platform board 6-pin power 12V 12V NC NC GND GND
PC 6-pin PCIe power GND GND GND 12V 12V 12V

m Caution
Do not plug PC 6-pin PCle power cable in platform board 6-pin power connector (J181)

HANYANG
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Development Software Components

m Xilinx Vivado

Generates a FPGA bitstream

Exports the generated FPGA bitstream to Xilinx SDK
m Xilinx SDK

Builds a SSD controller firmware

Downloads a FPGA bitstream and a firmware to the Zynq FPGA
m FPGA bitstream

Used to configure the programmable logic side of Zynqg FPGA
m Firmware

Manages the NAND flash array
Handles NVMe commands

HANYANG
UNIVERSITY
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Host System Software Architecture

[
Application
File System \
Host Computer Block Layer > Operating System
Device Driver
. J

Cosmos+ OpenSSD Firmware

Board Support Package

Software Layer

Hardware Layer

Cosmos+ OpenSSD <

ARM Processor, NAND Flash NVMe
K Cache Controller Controller
— /
‘\\//*
Hard-wired Bitstream

HANYANG
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Software Porting Flow

FPGA Bitstream Build Flow Firmware Build Flow

P ] N o mm mm o S Em O Em O Em S Em S Em S Em O Em Em Em e e
i \
: ¥ .
Xilinx Download | 1 Xjlinx Cosmost | |
) ' Predefined o OpenSSD I
Vivado : Project File : I SDK Firmware I
|
| | : |
Prbject and IP | . .
sdurce files I : Source f|Ie§I (.c file)
I v 1 I
|

| | I |

I I . Generate Board
Generate I Load .hdf File . . I
: Bitstream l into Xilinx SDK Suppo_rt FEIELERE Sl gk 1
I I I (Library) I
| | ) |
\_________/ N o e e e e e e e e e e e e e e e e e e e o o e e 4

Firmware

| executable (.elf file)
y

FPGA bitstream (.bit)

‘( Download to

" FPGA
2V
HANYANG
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Cosmos+ OpenSSD Internal System Overview

DDR3-1066
1 GB DRAM
A .
32 | NVMe DMA Engine Xilinx 7-Series Host
Integrated < > PC
v 64 Block for PCle PCI Express
DDR3 NVMe Controller Gen2 8-Laneg
Memory <
Controller Host Interface
FPGA to i
Memory < ]
Interconnect Xea I32x4
L Data Path Low-level NAND
< f NAND Flash »
- Dispatcher Controller d Die
] Command Path (Phy)
ARM
Cortex-A9 NAND Flash Controller (NFC)
- 64 _—
Dual-core X4
| tCentral t 32%4 I
nterconnec < q |
- > 'I I
Data Path . NERAEIE S| NAND
Dispatcher Controller d Die
Zynq Processing System i Command Path (Phy) :
Zyng-7000 FPGA NAND Flash Controller (NFC)
(XC7Z045FFG900-3) X4

HANYANG
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System Bus Structure

m General Purpose (GP) AXI4 Lite bus P A
32bits interface “ﬂ?ﬁter) . .
Used for control

Operates @ 100MHz

HP AXI ports
(slave)

\ 4

A

NVMe Host Controller

A

m High Performance (HP) AXI4 bus | newo
64bits interface Controller
Used for Direct Memory Access (DMA) (C)I(winnel 4~7)
Operates @ 250 MHz

NAND
Flash

'«—————— Controller

X4
v v (Channel 0~3)

HANYANG
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NAND Flash Controller Overview

< 3 A >
32 32
\ 4 v
Bus Interface Bus Interface
a
e . .Y _________
| i Request
i Command Filter 0 ! Completion
e 1 Marker
Voo

BCH ECC Engine

N

\ 4

i Command Filter N i Data Scrambler

____________________ 1
a A
\ 4 \ 4
Dispatcher

—— Command path T

\ 4

— Data path
__ Not present, Low-level NAND Flash Controller (Phy)
but possible Y
8

v

HANYANG
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Layered and Modular NFC Design \\t\

m Commands and data streams are encapsulated or decapsulated
throughout modules in a layer

m Users can insert or remove modules more easily

l AXl4 (Page + Spare)

Bus Interface

l Page + Spare

BCH ECC
Engine

v ED (Page) + ED (Spare)

Data Scrambler
SCRB (x): Scrambled data l

ED (x): BCH-encoded data SCRB (ED (Page) + ED (Spare))

HANYANG
UNIVERSITY
ENGLab . 33



Pipelined NFC Operation

m Data transfers throughout a layer from DRAM to NAND flash or
from NAND flash to DRAM are all pipelined

m Page buffer is not required in channel controller

]
Request 0 Bus Data Transfer |

1
BCH Encodinq

1
Data Scrambling

1
Request 1 E Bus Data Transfer i

i BCH Encodiné

i Data Scrar%lbling
Request 2 Bus Data Transfer

BCH Encoding

Data Scrambling

» Time

HANYANG
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T -

Software-controlled NAND Flash Scheduler Y

Hardware-level way scheduler of NFC in Cosmos OpenSSD is removed
FTL is now responsible for channel and way scheduling
This enables more flexible scheduling policy

FTL FTL
Channel Scheduler Chaggﬁgzﬂﬁeyvay
Low Level Driver Low Level Driver
= '
Way Way [ "°-- = =
ommand Queue
Queue Queue Way Scheduler Q
Way Scheduler (FCFS)
(Rogpd Robin)
Way Way -
Controller Controller ity Calier
NFC NFC
NFC in Cosmos OpenSSD NFC in Cosmos+ OpenSSD
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BCH ECC Engine with Shared-KES

m Key equation solver (KES) used more (250 %) of logic cells than
syndrome calculator and chien searcher

m Shared-KES saves 40 % of logic cells used in a BCH ECC decoder

m Short BCH code parallelization is applied for high utilization of
hardware resources

O )
Channel #0 |  SCbundie | )) ) CSbundle
Channel #1 | SCbundle | )) ) CSbundle
Shared-KES
Channel #2 | SCbundle | )) )| CSbundle
Channel #3  SCbundle | )) )| CSbundle

~

* (256 B x 2) bundle, (13 x 2) bit error correction, (8 bit x 2) parallel level

HANYANG
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NVMe Host Interface Overview

—— Command path
— Data path

HANYANG
UNIV

NIVERSITY

Embedded Network Computing Lab.
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32

A

64

v

Bus Interface

\ 4

Bus Interface

\ 4

AXI AXI
NVMe DMA Read Write
CMD CMD Channel Channel
FIFO FIFO ‘\ 1 T
1 1 PCle
v v DMA Engine
NVMe DMA / v [
CMD enile PCle PCle
Status Status Write Write
Checker Checker Channel Channel

A

a

a

\ 4

\ 4

PCle Transceiver

3

128

\ 4

Xilinx 7 Series P

Cl Express Core

A

PCI Express
y

AN
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Automated NVMe I0 Command Completion

m The NVMe host interface completes NVMe 10 commands
automatically

m The FTL does not need to be involved in the completion process

NVMe 10 Command Polling NVMe 10 Command Polling
Access NVMe 1O command Access NVMe 10 command
DMA Command Queueing (10 Data) DMA Command Queueing (IO Data)
a a
a a
a a

DMA Command Queueing (10 Data) EMA Command Queueing (10 Data)

- =N

DMA Transfer Complete Interrupt

DMA Command Queuein
9
(NVMe 10 Completion Command)

o

DMA Transfer Complete Interrupt

NVMe 10 Command Complete Interrupt

NVMe Storage NVMe Host NVMe Storage NVMe Host
Device Firmware Interface Device Firmware Interface

HANYANG
UNIVERSITY
Embeﬁed%twol:gng\gmb. 38



NVMe Host Interface Specification

m NVMe specification 1.1/1.2 compliant
» Up to 8 IO submission/completion queues - 256 entries each
» 512B and 4KB sector size
» Physical region page (PRP) data transfer mechanism
» Native device driver for Windows 8/8.1 and Linux kernel>=3.3
« OpenFabrics Alliance (OFA) NVMe driver for Windows 7 and later

NVMe Interface Performance (DRAM Disk)

Random 4KB 300K IOPS 300K IOPS
128KB 1.7 GB/s 1.7 GB/s

HANYANG
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Firmware FTL Features

LRU data buffer management

» Data transfer between host system and NAND flash memory via data buffer
» Eviction of LRU buffer entry

Pure page-level mapping (16 KB page)

+ Static mapping
+ Channel/way interleaving

Greedy garbage collection

* On-demand garbage collection
» Greedy selection of GC victims

Command Set

+ Single plane flash commands
« DMA commands for data transfer between host system and SSD

Priority-based scheduling

* Predetermined priority between DMA commands and flash commands
* Out of order execution between commands accessing different flash dies

HANYANG
UNIVERSITY
ENGLab .
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Firmware Overall Sequence

FTL initializing

Host command
fetching

: No Command
@ CMD: scheduling & issue

Yes

N

Is command
gueue full?

Data buffer
_____searching

DMA command Push to command

gueue

Buffer hit?

Garbage collection Flash command

Yes

Address translation

HANYANG
UNIVERSITY
ENGLab . 4L




LRU Data Buffer Management

m Buffer entry eviction
LRU buffer entry is evicted to allocate a buffer entry for a new request

Host request Read LPN 10
Buffer entry 0 LPN 16 MRU i Buffer entry 3 LPN 10 MRU
Buffer entry 1 LPN 4 ' Buffer entry 0 LPN 16
Buffer entry 2 LPN 7 Buffer entry 1 LPN 4
Buffer entry 3 LPN 2 LRU Buffer entry 2 LPN 7 LRU

Buffer entries Buffer entries

€

Reformed request Read LPN 10 Buffer entry 3

<_____

Address Translator

HANYANG
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Page-level Mapping \N

Main Idea

Every logical page is mapped to a corresponding physical page
Advantage

Better performance over random write than block-level mapping
Disadvantage

Huge amount of memory space requirement for the mapping table

. data area spare area
Ipn: logical page number
ppn: physical page number ppn 0
ppn 1
lpn  ppn opn 2 Block 0
0 12
“write(5, a)” 1 1 ppn 3
2 10
3 9 Block 1
4 8
5 7 / a
6 6
7 5 Block 2
8 4
9 3
10 2
1 1 Block 3
120 ppn 15

mapping table flash memory

NYANG
VERSITY
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Static Mapping

m Mapping tables are managed within a die
« Simple channel/way interleaving for sequential logical access

Way 0 Way 1
Channel O ! !

Way 0 Way 1
Channel 1 ! !

Each LPN is deterministically mapped to specific die (ex. 2-channel, 2-way)
HANYANG
UNIVERSITY
ENC Lab LPN: Logical Page Number 44

Embedded Network Computing Lab.



Concept of Garbage Collection

m Why is garbage collection needed

To reclaim new free blocks for future write requests
- Invalid data occupy storage space before GC

m What is garbage collection
Copies the valid data into a new free block and erases the original invalid data
Basic operations involved in GC are the following
- 1. The victim blocks meeting the conditions are selected for erasure
- 2. The valid physical pages are copied into a free block
- 3. The selected physical blocks are erased

®m What is important in GC

Victim block selection
- GC time depends on the status of victim block

45
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On-demand GC

m GC Trigger
Each GC is triggered independently of other dies
GC is triggered when there is no free user block of each die

m Blocks in GC
One block per die is overprovisioned
Single victim block is a target of GC

| ! .

Victim block Free block Free block Returned block

7/

/7

Valid pages in victim block are copied to free block and the role of two blocks are swapped

HANYANG _

UNIVERSITY Source file: pagemap.c
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Firmware Command Set

Commands for NAND flash controller

V2FCommand_ReadPageTrigger

» Read data of a flash page
» Store data to register of the flash die

Commands for NVMe DMA engine

V2FCommand_ReadPageTransfer
LLSCommand_RxDMA » Transfer data from a flash die to data buffer
» Transfer data from host system to data buffer » Inform bit error information to FTL
LLSCommand_TxDMA V2FCommand_ProgramPage
» Transfer data from data buffer to host system » Transfer data from data buffer to a flash die

» Program data to a flash page

V2FCommand_BlockErase
» Erase a flash block
V2FCommand_StatusCheck

» Check a previous command execution result

HANYANG
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Priority-based Scheduling \N

Waiting commands are issued by scheduler
Scheduler checks the state of flash memory controller and host interface controller
Priority of flash commands enhance multi channel, way parallellsm

Cp_eratmn done-
REqUEStISSUE C-peraticn Cperatlcndcne Retr}"
Fail D one
Freucus
Way 0 Way ! Way N Request Issue B
""""""" Cperatlcn fail
Fail count =
Channel 0 Retry limit
NVMe DMA

engine
Channel 1

Scheduler

NAND Flash

Controller

Channel X

O O
o O
S O

Command Priority

LLSCommand_RxDMA 0

Command queues LLSCommand_TxDMA
V2FCommand_StatusCheck

V2FCommand_ReadPageTrigger

V2FCommand_ProgramPage

0

1

2

V2FCommand_BlockErase 3

4
D‘EY RASrI\lTGY @ V2FCommand_ReadPageTransfer 5



Known Restrictions (1/3)

m Firmware
Supports
- Buffer management (LRU)
- Static page mapping
- Garbage collection (On-demand)

Not supports
- Meta flush
- Wear leveling

Notice

- |/ O performance can be degraded when performing garbage collection
- The number of usable blocks is limited when the MLC NAND array is used in the 8-

channel 8-way structure

- The latest firmware in SLC mode accesses only LSB pages of MLC NAND
- Accessing to MSB pages may cause data errors not able to be corrected by ECC

49



MSB Page Data Error Issue

m The bit error rate increases if MSB pages of NAND flash are accessed

m Increased bit errors might not be corrected by BCH error correction
engine in the current version of NAND flash controller

m For now, the firmware runs in SLC mode in order to reduce the error
rate due to this reason

HANYANG
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SLC Mode of Firmware

m Currently, MLC to SLC mode transition command of NAND flash is not
supported

m Accessing only LSB pages achieves similar characteristics to real SLC
NAND flash

1 1
! Paired pag? address

i LSB pages I MSB pages
| 00h - 02h

1 L

[ 01h ' 04h

1 ol

1 o

| :

- FDh | FFh
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Known Restrictions (2/3)

PCle-NVMe

Supports
- Up to PCle Gen2.0 x8 lanes
- Mendatary NVMe commands
- PRP data transfer mechanism and out-of-order data transfer in PRP list
- 1 namespce (can be extended by updating firmware)
- Up to 8 NVMe 10 submission queues and 8 NVMe 10 completion queues with 256 depths
- Up to 256 depths internal NVMe command table
- MSI interrupt with 8 interrupt vectors
- X86/x64 Ubuntu 14.04 and Windows 8.1

Not supports
- 4 byte addressing yet (on debugging)
- Optional NVMe commands (can be supported by updating firmware)
- SGL data transfer mechanism
- Power management (can be supported by updating firmware)
- MSI-X interrupt
- Virtualization and sharing features
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Known Restrictions (3/3)

m NAND flash controller

Supports
- Channel can be configured up to 8
- Maximum bandwidth of NAND flash bus 200 MT

Not supports
- Additional advanced commands are not supported (e.g. multi-plane operation)
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Get Started with Cosmos+ OpenSSD



Overall Steps

m Preparing development environment
Host computer
Platform board
Development tools

m Building materials
FPGA bitstream
Firmware

m Operating Cosmos+ OpenSSD
Bitstream and firmware download to the FPGA
Host computer boot and SSD recognition check
SSD format
SSD performance evaluation and analysis

HANYANG
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Tested Host PC Mainboard Compositions

BIOS Ver.

Asrock Z77 Extream 6 P2.40 Working
ASUS H87-Pro 0806x64  Working
Gigabyte H97-Gaming 3 F5 Working
Gigabyte Z97X-UD5H F8 Working
F10c Not working 4-byte addressing problems in

Cosmos+ PCle DMA engine

HANYANG
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Tested Host PC Operating System

_ x86/x64

Windows 7 Working with OFA driver
Windows 8.1 X64 Working

i i 4-byte addressi blems in C
Windows 10 X64 Not working OSH{; s éf;%ﬁf;‘;gﬂgs n
Ubuntu 14.04 LTS or x64 Working Kernel version 3.13 or
above above

HANYANG
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Preparing the Platform Board

m Check jumper pins of the platform board
m Insert NAND flash module(s)

m Connect the external PCle cable

m Connect the USB cable for jtag

m Connect the USB cable for UART

m Connect the power cable

HANYANG
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Check Platform Board Jumper Pins (1 / 5) \

N

m Make sure that jumper pins on board are set as default below

ouewccmx,k

& R388
=t

-3 8

]
~c
S
xa

<BE
EE
™ @7
gl

R149

R8O U147
R585[ % usy

Cass[® . . .. ¢

Py

! 1_MGTVCCAUX

J79 J75 J76 J77 )78
00, 00, 00,00 00
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Check Platform Board Jumper Pins (2 / 5)

m Make sure that jumper pins on board are set as default below

FEE 11C_PMOD
O EEEECEEE] PMOD_0 PMOD_4p>
026 ”“ ce2™ |
i PMOD_1 PMOD_5
le PMOD_2 PMOD_6
] PMOD_3 PMOD_7

GND GND

VCC3V3_PS

Ui
23382 & J177
R2TES
'i“.‘..a, . .
( N J
[ X J
( N
SEv — - R338
g = = R349 iﬂﬂiiﬂ -
§13EE.3 -
362 -
R36:H o
R36?
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Check Platform Board Jumper Pins (3 / 5)

m Make sure that jumper pins on board are set as default below

R22 U101 pgg LD5

Mﬁ--@@ o 3
od o - o
— 3 [l gm: TL'“;I m
R99 A -m:m
C660 €685 D4Rata A
. ESER ‘€ i
U106 :
- s { N )
-2 DEVICE MODE i ™ T .
2-3 HOST OR OTG MODE| Q46 < J30 J29 J28 J31
o e 9o ©
o O o e
o 6 o o
ORI IR R RN R IR D)
A 52
:
- B
=
z c551Fq [
5 Li11Ca27L12
= v
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Check Platform Board Jumper Pins (4 / 5)

m Make sure that jumper pins on board are set as default below

= A

uuuuuulll Ci23

LT

R259 \
czaz CZBl c203 ] s s

. c625  Co24  Co27
‘] . R296 3 .
C3T5E3 'Eg =
o e
. °F

ﬁ mamm

a
e
o
=
3
o
Wlo
"
«

oo}

J188

X
[ X)
7

et : nes 22
N X

J184
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J85 J87 J86 J88
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e o o
® O J35
® ® J36
J187
( X
( X
oo J186
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Check Platform Board Jumper Pins (5 / 5)

m Make sure that jumper pins on board are set as default below

J89 J8o J74
| X J 000, 000

MS 8 L34S Sde

>
L
©

~n
-

Flo
=
0TS¥[]  we
mm VIS s

1|
a3
[l

Technology Co., Ltd.
&r‘\m 2 I_VCC_NAND_IO i
el & GND_TP y 1_VCCO_ADJ U156

\
> [p

(s N3]
——

iy 2seEm =
W

s =

(=
(2]

1

000A 1
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Insert NAND Flash Modules

m A single NAND flash module can support up to 4-channel configuration
« For prebuild 3.0.0, two NAND flash modules are required
» For predefined project 1.0.0, one NAND flash module is required
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Connect External PCle Cable (1/ 2)

m Hold external PCle connector and push the cable in it
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Connect External PCle Cable (2 / 2)

m Make sure that the cable is fixed tightly
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Connect USBJTAG Cable

m USBJTAG requires a micro-USB type B (male) to USB type A (male)
cable

o St Ll s T e i e i

USB type A

/!

USB type micro B
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Connect USBUART Serial Communication Cable

m USBUART requires a USB type A (male) to USB type A (male) cable

USB type A

HANYANG
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Connect Power Cable

m Connect the power cable to the 5.5 mm power connector

R

= R
e
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—

Preparing Software for Development PC

m Download materials
Prebuilt FPGA bitstream
Pre-defined Vivado project for manual FPGA bitstream generation
Firmware source code

m Install Xilinx Vivado Design Suite: System Edition 2014.4
Xilinx Vivado 2014.4
Xilinx SDK 2014.4

HANYANG
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Download Materials (1 / 3)

m Go to the OpenSSD project site, and click “Resources”

B a | 5 The OpenssD Project X [ S5 - —

& : O o (@ www.openssd.io, e = 7 @

SSD

OPEN-SOURCE SOLID-STATE DRIVE PROJECT FOR RESEARCH AND EDUCATION

HOME PUBLICATIONS FORUM PEOPLE RELATED LINKS

http://www.openssd.io
R

IT'S OPEN-SOURCE IT'S MODULAR IT'S REAL
All materials including documents, firmwares, All software and hardware designs consist of Areal hardware board, called Cosmos OpenSSD
hardware RTL sources, and platform board many replaceable modules and offer flexibility platform, is a part of Cosmos OpenSSD system.
schematics are fully accessible to the public. in their re-design. It operates as a real solid-state drive.
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Download Materials (2 / 3)

m Click “Source”

B a | 5 The OpenssD Project X | + v

<« - O m @ www.openssd.io/resources html Y = 7 e

OrenSSD

OPEN-SOURCE SOLID-STATE DRIVE PROJECT FOR RESEARCH AND EDUCATION

HOME PUBLICATIONS RESOURCES FORUM PEOPLE RELATED LINKS

Cosmos+ OpenSSD

Source
If you have one or more 1 TB (Toggle/NV-DDR2) NAND modules for Cosmos+ OpenSSD, you would need source codes for it.

& /4.

“ Tutorial
This tutorial introduces you to the basic concepts, features, and instructions of the Cosmos+ OpenSSD.

e

HANYANG
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Download Materials (3 / 3)

m Click “Clone or download” -> “Download ZIP”

B 3 | €) GitHub - Cosmos-Open | + = = m] X
< —= (9] {nt & GitHub, Inc. (US] httpsy//github.com/C hxd H= b/ =
O Features Business Explore Marketplace Pricing Sign in o' Sign up
£ Cosmos-OpenSSD / Cosmos-plus-OpenSSD ©Watch 15 | #eStar | 21 YFork | 24
<3 Code Issues 10 Pull requests 1 Projects 0 Insights

Cosmos OpenSSD + Hardware and Software source distribution

P 19 commits I 2 branches > 0 releases A2 2 contributors & GPL-3.0

Branch: master Find file ‘ Clone or download ~

Cosmos-OpenSSD Add GreedyFTL-3.0.0 (compatible with PreBuild-3.0.0 and Predefined-1... .- Clone with HTTPS O]
i doc 189 (on) -> 182 (off) @ p.63 Use Git ar checkout with SVN using the web URL.
https://github.com/Cosmos-OpenssD/Cosmos | [
| project Add GreedyFTL-3.0.0 (compatible with PreBuild-3.0.0 and Predefined-1....
M source Add GreedyFTL-3.0.0 (compatible with PreBuild-3.0.0 and Predefined-1....
Open in Desktop Download ZIP ’
| support support platform board boot using a firmware binary file w;h
LICENSE Initial commit 2 years ago
README.md Initial commit 2 years ago
(8 README.md

Cosmos-OpenSSD-plus
Cosmos OpenSSD + Hardware and Software source distribution

httpsy//github.com/Cosmos-OpenSSD/Cesmos-plus-OpenSSD/archive/master.zip

HANYANG
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Directory Tree of Downloaded Materials

m Materials include a prebuilt bitstream, a pre-defined project, and a
firmware source code

E—E Cosmos-plus-OpenSSD-master zip

v | | Cosmos-plus-OpenSSD-master Prebuild-3.0.0
v Prebuild (- —=—=—======-- \I
Prebuild-3.0.0 : GreedyFTL-2.7.0 |
v | | Source ;L] OpenSsD2-8CBW-Prebuild-3.0.0.hdf ,

W Firmware

GreedyFTL-2.7.0
|GrEE|:I],rFrL-2.T.1 Pre-defined project-1.0.0

v | | IPRepo \L’» """""""" =
IPRepo-1.0.0 GreedyFTL-2.7.1

v Predefined Project |

\
|
|

OpenSsD2_2Ch8Way-1.0.0 N OpenSSD2.sdk |
OpensSD2.srcs 1
|

/

g OpenSsD2 xpr

HANYANG
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Type of Bitstream and Firmware

-» @ Prebuild 3.0.0 SLC/MLC 1TB/2TB
=~ O Predefined 1.0.0 2 8 SLC/MLC 256 GB/512 GB
2.5.0
=» @ GreedyFTL 2.6.0 8 8 SLC 1TB
2.7.0
- O GreedyFTL 2.7.1 2 8 SLC 256 GB
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Remarks on the Type of Bitstream

Prebuild type

A prebuilt bitstream is included, so you can skip bitstream generation steps

Prebuild type is distributed as a hardware description file (.hdf) which consists of a

FPGA bitstream, bitstream information, and an initialization code for CPU in Zynq
FPGA

Pre-defined type

bitstream is not included, so you should follow bitstream generation steps

Pre-defined type is distributed as a vivado project file with register transfer level
(RTL) source codes of intellectual properties (IPs) such as NVMe controller
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Install Xilinx Vivado Design Suite

m Make sure that Vivado is system edition and that “Software
Development Kit” and “Zyng-7000” are checked

Vivado System Edition

Customize your installation by (de)selecting items in the tree below. Moving cursor over selections below
provide additional information.

Vivado Systemn Edition is a superset of Vivado Design Edition with the addition of Vivado High-Level Synthesis
Generator for DSP. Users can optionally add Software Development Kit to this installation.

= Design Tools

= Vivado Design Suite

o Vivado

System Generator for DSP
ra

Vivado Hioh | ayal EunHﬂu"iS

o Software Development Kit
| LIULINa
[—}' Devices
= [»| 7 Series
] Arix-7
Kintex-7

Kintex UltraScale
S [ Virtex UltraScale
=+ Installation Options
Install Cable Drivers
Acquire or Manage a License Key
Enable WebTalk to send usage statistics to Xilinx (Always enabled for WebPACK license)
Install WinPCap for Ethernet Hardware Co-simulation
Launch configuration manager to associate System Generator for DSP with MATLAB

HANYANG
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Generating FPGA Bitstream for Pre-defined Proje

Run synthesis

-

Run implementation

N

3. Generate bitstream

Export hardware

B
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Launch Xilinx Vivado

m Open the predefined project included in “OpenSSD2_2Ch8Way-1.0.0”

OpenssD2 sdk 2017-01-00 2% IY =4
OpenSSD2.srcs 2017-01-00 2= O =0
g OpenSSD2 2017-01-09 2% Vivado Project File 13KB

Fle Edt Fow Toos Window Layout View Hep

SRl avRB X P D> E S K L S| Soefutlayout - en| @ e
Flow Navigator « | Project Manager GpenssD2 i
Q= Sources 2 ¥ | | E Project Summary X | O x
| = e [
4 Project Manage! f]@‘dfﬁ"‘@ g Proje i Edit #

£ Project Settings = ‘D:g:::;;ée;(g;enswZ‘bd',- W | Projectname:  OpenssD2

¥ Add Sources (= Coefficent Files (1) Project location:  I:/Projects/OpenSSD2_2ChaWay_Release

) Language Templates :;“m"j::;””"s;:;s @ Z:d:;tf:rmtﬂv i:::tf:nngm .

I L5 Catog ru; mu;u\e name: QpenssSD2

< e Synthesis # | Implementation E3

4%, Create Block Design
5% Open Block Design Status: = Motstarted Status: = Notstarted

5 Generate Block Design P Sources |Ubraries 4 b @ Messages:  No errors or warnings Messages: No errors or warnings
Part: XeT2045ffg900-3 part: XeT2045f7g900-3
2 Sources
4 smuation Strategy:  Vivado Synthesis Defaults Strategy: Performance ExplorePostRoutePhysOpt
43 Simulation Settings Praperties - 0o x Constraints: synthesis Constraints: implementation

(), Run Simulation Incremental compile: hone

4 RIL Analysis DRC Violations % | Timing %
£
b Open Elaborated Design
= Ope & DRC information is not available because it hasr't been run Timing information is not avaiable because it hasn't been run
4 Synthesis
4 Synthesis Settings Lzl 2 ower =
@ Run synthesis Utiization information is not available because it hasn't been run Power information is not available because it hasn't been run
> {@F Open Synthesized Design
4 Implementation Design Runs _ope =
45 Tmplementation Settings A | Name Constraints ~ WNS NS WHS THS TPWS FailedRoutes LUT FF  BRAM DSP  Start Elapsed
[ Run Implementation 2@ o syntn 1 synthesis g
> [ Open Implemented Design| | g21 = impl_1 implementation Ne
4 Program and Debug »
43 Bitstream Settings M
%] Generate Bitstream »
> ¥ Open Hardware Manager «
LR i A=

|5 Td Console | > Messages | B Log | (% Reports, 3> Design Runs
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Run Synthesis (1/ 2)

m Click “Run Synthesis”

HANYANG

UNIVERSITY
ENC Lab

Embedded Network Computing Lab.

Flow Tools

File  Edit Window Layout View Help
AR e RE X P DB H X T (S [HoefutLayout & Ready
Flow Navigator « | Project Manager - OpenssD2 x|
a == Sources — O %X | [L Project Summary X | owv
el —] = o
| 4 Project Manager | A= wetii =1 Project Settings Edit #
i i & Design Sources (2) % Project name: OpenssD2
& Project settings # OpensSD2 (Opens5D2.bd) (1) . : P
Eﬁ Add Sources = Coeffident Files (1) Project location:  I:/Projects/Open3SD2_2Ch&Way _Release
ints (17}
o = Constraints (12) Product family: Zyng-7000
Y s & Simuiation Sources (2) Praject part: xc72045fg900-3
: x
4 1P Catalog Jeetp
I Top module name: OpenSsD2
4 TP Integrator
= C Synthesis F3 Implementation F3
# Create Block Design
5% Open Block Design Status: = Mot started Status: = Mot started
% Generate Block Design CEes | Libraries 4 » @ Messages: Mo errors or warnings Messages: Mo errors or warnings
Part: %c72045ffgo00-3 Part: %c72045ffgo00-3
- é Sources o o
4 Simulation Strategy:  Vivado Synthesis Defaults Strategy: Performance ExplorePostRoutePhysOpt
3 simulation Settings Properties —0Owe x Constraints: synthesis Constraints: implementation
@ Run Simulation Incremental compile: Mone
4 RTL Analysis DRC Violations E3 Timing E3
=]
3 Open Elaborated Design
=~ Ope g DRC information is not available because it hasn't been run Timing information is not available because it hasn't been run
4 Synthesis
Utilizatio ES Powel ES
ﬁ Synthesis Settings, rzation r
& Run Synthesis Utilization information is not available because it hasn't been run Power information is not available because it hasn't been run
4 r.ﬂ Open 5 i
Run Synthesis
4 Implementation |__Run synthesis on your project source files. O ox
£ Implementation Settings A | Name Constraints  WNS NS WHS THS TPWS  FaledRoutes LUT FF  BRAM DSP  Start Elapsed S
[ Run Implementation 2| = o synth_1 synthesis Mg
> [ Open Implemented Design = = impl_1 implementation N
4 Program and Debug ’
% Bitstream Settings N
%, Generate Bitstream »
[ iq} Open Hardware Manager «
L 4] ] A=
& Td Console LD Messages | [ Log | 5 Reports', 3+ Design Runs J
Run synthesis on your project source files ‘ it
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Run Synthesis (2 / 2)

m Synthesis is running...

T Fex® @vﬂm_design = Tl D

e —

x
JE Project Summary X ] O & =
=
=20l project Settings Edit #
5]
. Project name: OpenssD2
Project location:  I:jProjects/OpenssD2_2ChEWay_Release
Product family: Zyng-7000
Project part: wc7z045Hq300-3
Top module name:  CpenssD2
Synthesis -3 Implementation -3
Status: @nning synﬂﬂ_@ Status: = Not started
Messages: Mo errors or warnings Messages: Ma errors or warnings
Part: wCTz045fg900-3 Part: wCTz045fg900-3
Strategy:  Vivado Synthesis Defaults Strateqgy: Performance ExplorePostRoutePhys0pt
Constraints: synthesis Constraints: implementation
Incremental compile: Mone
HANYANG
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Synthesis Complete E |

m Select “Run Implementation” and click OK

If you want to see the synthesized results, choose “Open Synthesized Design” or
“View Reports”

Synthesis Completed @

(7) Open Synthesized Design

(7 View Reports

[] Don't show this dialog again

[ K ] [ Cancel

4@
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Run Implementation

® Implementation is running...

X|
szl‘ﬂjectﬁllmmw x] O =
=2} -~
=l project Settings Edit = —
(=]
- Project name: OpenSshi2
Project location:  I:/Projects/OpenssD2_2CheWay_Release
Product family: Zyng-7000
Project part: ¥ 72045 g300-3
Top module name: Opensshi2
Synthesis #  Implementation @ 3
Status: +f Complete Status: {_/ Running Design Initialization
Messages: (1) & critical warnings Messages: Mo errors or warnings
(1) 595 warnings Part: wc7z045fF0900-3
Part: wCFz045ffg300-3 Strateqgy: Performance ExplorePostRoutePhysOpt
Strateqy:  Vivado Synthesis Defaults Constraints: implementation
Constraints: synthesis Incremental compile: Mone
HANYANG
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Warning Message

m The following critical messages appear when implementation is
running, but you can ignore it

“ ||_ Top module name: CpenssD2
-

;'EJ_,.. Launch Run Critical Messages ﬂ

3 ; lj There were 100 critical warning messages launching implementation run.

Messages

"""" (1) [Common 17-55] 'set_property’ expects at least one object. [I:/Projects/OpenssD2_2Chaway | Ru =
OpenssD2.srosfconstrs_1fimplementation/pinmap_nand_ch?2.xdc:45] B
Resolution: If [get_<wvalue>] was used to populate the object, check to make
sure this comm and returns at least one valid object,

(1) [Common 17-55] 'zet_property’ expects at least one object. [1:/Projects/OpenssD2_2Chaway R
Opens502.srosfconstrs_1fimplementation/pinmap_nand_ch2. xdc:46]

Resolution: If [get_<value =] was used to populate the object, check to make i
sure this comm and returns at least one valid object.

(1 [Common 17-55] 'set_property' expects at least one object. [I:/Projects/Opens5D2_2ChaWay R
OpenssD2.sresfoconstrs_1fimplementation /fpinmap_nand_ch2. xdc:47]

Resolution: If [get_<value =] was used to populate the object, check to make
sure this comm and returns at least one valid object,
(T [ammon 17-551 'zt nranerhe evnects at leact ane ahiect [T Praiects MnenSSN 7 2rhaitiay D:@

-

OK |[ Cancel Run H Open Mezsages View ]
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Implementation Complete

m Check the status of synthesis and implementation

v ! & \| '3-‘\:) Implementation Complete I
x|
% Project Summary x] O %
: Project Settings Edit = -
I Project name: OpenSs02

Project location:  I:/Projects/OpenSsD2_2ChaWay_Release
Product family: Zyng-7000
Project part: xc7z045ffg900-3

m

Top module name: OpenssSD2

Synthesis 3 Implementation

b

 status: +f Complete

Messages, warnings Messages: 0 critical warnings

(1) 535 warnings (D) 304 warnings | |
Part: xc7z045ffga00-3 Part: xc7z045ffg200-3
Strategy:  Vivado Synthesis Defaults Strategy: Performance ExplorePostRoutePhysOpt

Constraints: synthesis Constraints: implementation

Incremental compile: Mone

Route Status |

DRC Violations 3 Timing - Post-Implementation -3
Summary: @ 0 errors Worst Negative Slack (WNS): 0.051ns
(? 0 critical warnings Total Negative Slack {TNS):  0Ons
"%) 88 warnings Mumber of Failing Endpoints: 0 -
......... )
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Generate Bitstream (1 / 2)

m Click “Generate Bitstream”

4 Tmplementation Log

{3 Implementation Settings 0l Writing ¥0EF routing special nets.

[» Run Implementation ,fj Write ¥0EF Complete: Time {5 cpu = O
> g% Open Implemented Design| || [3 > write_checkpoint: Time (s): cpu = 00:0C
L INFD: [Timing 38-91] UpdateTiminaParams

4 Program and Debug INFO: [Timing 38-191] Multithreading er
{f Bitstream Settings report_timing_summary: Time (s): cpu =
¥ Generate Bitst’eam‘ INFO: [Common 17-206] Exiting Yivado at

e ;
> [§P OpenHardwa Generate Bitstream

Generate a programming file after implementation.

Synthesis | Implementation | Simulation

= Td Console | > Messages- L&l Log | (2 F
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Generate Bitstream (2 / 2)

m Generate bitstream is running...

File Edit Fow Tools Window Layout View Help
A oevBRBE X P D E S X L G| Coefultlayout [ & 9" Running write_bitstream = /[ Cancel |
Flow Navigator « | | Project Manager - OpenssD2 x|
a=zZ= Sources - O % | [ Projectsummary X o x
= e =
A= Wt R = = . ; -
|A Project Manager | IZ’ Project Settings Edit %
= Design Sources (2) = Broject . OpenssD2
ﬁ Project Settings 4 OpenssD2 (Cpenssnz.bd) (1) roject name: pen:
E)? Add Sources = Coefficent Files (1) Project location:  I:/Projects/OpenSSD2_2Ch8Way_Release
-5 Constraints (12) ily: -
o = (12) Product family: Zyng-7000
y e (@ Simudation Sources (2) Project part: xcT20456q300-3
. -
1} IP Catalog Jectp I
Top module name: OpenSSD2 =
4 1P Integrator
n- grater Synthesis F-3 Implementation F-3
ﬁ Create Block Design
5% Open Block Design Status:  «f Complete Status: ) Running write_bitstream
& Generate Block Design 1P Sources |Libraries 4 b @ i Messages: @ & itical warnings Messages: @ 100 critical warninas
imulati (4 s=smeminas ® 304 warnings B
4 Simulation = m Part: ¥c72045ffg900-3 Part: xc7z045ffg300-3
&3 simulation Settings Properties - 0o x Strategy:  Vivado Synthesis Defaults Strategy: Performance ExnlorePostRoutePhysOpt
(I}, Run Simulation Constraints: synthesis Constraints: implementation
Incremental compile: Mone
4 RTL Analysis :
H _Summarv Route Status
s 5“ Open Elaborated Design _ |
DRC Violations E3 Timing - Post-Implementation E3
4 Synthesis
Synthesis Settings .
8 s & Summary: @ 0 errors Worst Negative Slack (WNS): 0.051ns
& Run synthesis ® 0 itical warnings Total Negative Slack {TNS):  Ons
=1 vami
> @ Open Synthesized Design 1) 88 warmings MNumber of Failing Endpeints: 0 -
4 Implementation Log _ 0O @ %
43 Implementation Settings [[||INFO: [Timing 38-191] Multithreading enabled for timing update using & maxinum of 2 CPUs B
[ Run Implementation ,‘_gj report_timing_sunmary: Time (s): cpu = 00:00:15 ; elapsed = 00:00:10 . Memory {MB): peak = 2107.070 ; gain = 0.000
> g% Open Implemented Design ._é INFO: [Common 17-208] Exiting YWivado at Thu Jan OB 11:27:25 2017...
4 Program and Debug +++ RUNNing vivado
3 Bitstream Settings with args -1og Open3302.vdi -appiog -nGd -messagelb vivado.pb -mode batch -source OpenSSDE.tol -notrace
m Generate Bitstream
> i‘a‘ Open Hardware Manager B
€ i, 3
Synthesis | Implementation | Simulation ‘
= Tdl Consale L':- Messages . [=] Log | [2) Reports L§> Design Runs
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Bitstream Generation Complete

m If you want to see the implemented design, select open implemented
design and click the OK button

F N
Bitstream Generation Completed ﬁ

—
e

o
@) Bitstream Generation successfully completed.
R -

Mext

i@ Dpen Implemented Desigre

i) View R 1=
) SIeW Epar Analyze a

=

() Open Hardware Manager

[] Don't show this dialog again

Ok ] [ Cancel
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Export hardware (1/ 2)

m Go to File -> Export and click “Export Hardware”

File | Edit Flow Tools Window Layout View Help

& Mew Project... ﬁ| & %| % [E | 23 efaul
[#* Open Project... -
Open Recent Project ] ot Mannger Openen2
Open Example Project [ - o
<=2 el R

Save Project As...

{= Design Sources (2]

pEERRIe Lo [}, OpenSSD2 (OpenssD2.bd) (1)
A Archive Project... -5 Coeffident Files (1)
Close Project {5 Constraints (12)
I Simulation Sources (2]
Open Checkpoint. ..

Mew IP Location...

Open IP Location. ..

5 jerarchy IPSouroes|Libraries 4 )
& Sources | ' Templates

Neﬂ Flle == N C T TR
Open File... Ctrl+ O [Perties —ov
Open Recent File | = k

Open IP-XACT File. ..

B Ctrl+5
B Add Sources... Alt+A
Open Source File... Ctrl+M
| Export 4 || Export Hardware... |
Launch SDK %i| Export Bitstream File. .. [
fmnlns INFD: [¥ivado 12-1642] Bitgen
Coeriomd i INFO: [Project 1-118] WebTalk
® Frint.. Ctrl+P ||| INFO: [Common 17-83] Releasing
Exit write_bitstream: Time (s): cpu
e — IWADK KR [Wiuada Tel A-3101 Fi
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Export hardware (2 / 2)

m Select the “Include bitstream” and click OK

rﬁ_—, Export Hardware ﬁ1

Export hardware platform for software development
tools.

Export to: | B0 <Local to Project= -

| ok || Cancel

‘ )
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Launch SDK (1/ 4)

m Go to File -> Launch SDK

File | Edit Flow Tools Window Layout View Help

#&  New Project... m| ﬁ %| z LQ 09 pefault Layoul

[  Open Project...
pject Manager - OpenSsSD2

Open Recent Project 3
A
Open Example Project p [rces _ O v =
el —
Save Project As... = 2 Sﬁl .

{= Design Sources (2]
[, Opens5D2 (OpenssD2.bd) (1)
CL Archive Project... [ Coeffident Files {1)
Close Project I Constraints (12)
{9 Simulation Sources (2)

Write Project Tdl...

Open Checkpaint...

Open Regent

MNew IP Location. ..

Cpen IP Location...
5 jerarchy | IP Sources|Libraries 4 » B

Sources | ) Templates
New File. ., & L\' ...... = I

Open File... Ctrl+ [PeErties _Ouwv =
Cpen Recent File » | = 3

Open IP-XACT File...

Open Recent I

B Ctrl+5
@ Add Sources... Alt+ A
Open Source File... Ctrl+N
Expoct h
| Launchsok |
OenlLogFle INFO: [¥ivado 12-1842] Bitaen Cample
EEUIE s INFO: [Project 1-118] WehTalk data c
¥ Print.. Ctrl+P |||INFO: [Common 17-83] Releasing licen
Exit write_bitstream: Time (s): cpu = 00:
= MACRITRIZ . T ads Tt 4 20T T la M
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Launch SDK (2 / 4)

m Click the OK button

rﬂ} Launch SDK [

Launch software development toal,

Exported location: |5ﬂ <Local to Project> = |

Workspace: |Eﬂ <Local to Project > - |

ok [ cancel |

- ——
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Launch SDK (3 / 4)

m Then, SDK is launched

| - | L || project Settings
1 Sources (2) =

2en55D2 (OpenssDz.bd) (1) Project name: Open55D2

wefficient Files (1) Projectlocation:  [:/Projects/OpensSD2_2ChaWay_Release
raints (12) Product family: Zyng-7000

ition Sources (2)

Project part: ®c7z045ffq300-3
Top module name:  OpenssD2

DK

Software Development Kit
20144

i‘ XI LI NX Copyright 1986-2014 Xilinx, Inc.
All Rights Reserved.

ALL PROGRAMMABLE.

[¥ivado 12-1847] Bitgen Conpleted Successfully,
[Project 1-118] WebTalk data collection is enabled (User setting is ON. Install 3etting is ON.).
[Common 17-83] Releasing |icense: Implementation
aitstream: Time (s): cpu = 00:02:43 ; elapsed = 00:02:43 . Memory (MB): peak = 2003.164 . gain = 491.70%
i [Wivado_Tel 4-319] File Open3502.mmi does not exist

|1 /Projects/0pen3S02_2ChEllay_Release/0pen3S02. runsd inpl _1/ . X1 /Y ivado-499416-aCentaur i /HIH/ Open5502_bd.
[Common 17-206] Exiting Yivado at Thu Jan 05 11:43:52 2017...
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Launch SDK (4 / 4)

m As shown below, exported hardware platform is set as target hardware

m C/C++ - Open55D2_hw_platform_0/system.hdf - Xilinx SDK

File Edit 5ource Refactor MNavigate Search Project Xilinx Tools Run Window Help
i |%vv@¥'g \@\@vﬁﬁvlﬁv@vﬁv{)v%v@g"vu 0 & « &
Quick Access

[?5 Project Explorer 52 = B ||l system.hdf S@l = 8|

-~

OpenSSD2_hw_platform_0 Hardware Platform Specification
[ E OpenS502_hw_platform_0

m

Design Information

Target FPGA Device: 72045
Created With: Vivado 201441
Created On: TueJan 03 13:09:53 2017

Address Map for processor ps7_cortexa9_0

NYMeHostController 0 0=83c00000 0=83c0f£f££
TigerdNSC_0 0=43c00000 0x43cDffff
TigerdNSC 1 0x43=10000 Oxd3clffff

ps7_afi 0 0=f£8008000 OxfH8008E£E

psi_afi 1 O=£B3009000 Oxf3009fff

ps7_afi_ 2 0=f800a000 Oxfa00afff

ps7_afi_3 0=£500b000 Oxf800bifE
ps7_coresight_comp_0 0x=£2800000 Ox{f80ff££f
psT_ddr 0 0=00100000 Ox3f£££££F

ps?_ddrc 0 0=£B3006000 OxfS006Ef£f
psT_dev_cfg 0 0=£B8007000 Ox£80070££
ps7_dma_ns 0=f2004000 OxfB004££F
ps7_dma_s 0=£8003000 0=fR003£££

000b000 Oze000bf£f£ S
Overview

4 Target Connections &2 = 8 ||[& Preb.. 2 l;—:' Tasks| = Cons...| = Prop.. | & Ter.., | = 0 SDK Log &2

2% i || 11:58:1@ INFO  : Processing

A Local [default] 0 items 11:58:13 WARN : Unable to

- . c 11:58:14 INFO @ Checking 1

> @ Auto Discovered Dt fesoucs 11:58:14 INFO  : Launching
HANYANG
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Building Firmware for Pre-defined Project

1. Create a new application project
2. Add source codes

3. Build firmware source codes
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Create a New Application Project

m Go to File -> New -> Application Project

Bl c/c++ - OpenssD2_hw_platform_0/systerm.hdf - Xilinx SDK
Eile Edit Scurce Refactor Mavigate Search  Project  Xilinx Tools Bun Window  Help
Mew Alt+Shift=N > (&) Application Project - Q
Open File_. 1 SPM Project
Clase Ctrl+W Wk, Board Support Package
Close Al Ctrl-shiftsw | [ Project.. Bk
Save Ctrlet f% Source Folder
Save As [3; sl _ ;45
save All Ctrl+shift~s | € Source File yivad
Revert 'h Header File Tue Jd
| File from Temnplate
Move... G Class [esso)
Rename... F2 N ) Oxf
& Refresh Es CY Other... Ctrl+M ) Ot
Convert Line Delimiters To > TigerdNSC_1 O=é
neT ofi 0 [
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Specify the Project Name

m Fill in the project name and click “Next”

@ Mew Project O pas

Application Project _
Create 3 managed make application project. @

Project namel GreedyFTL| I |

Use default location

Location: | C:WCosmos-plus-OpenSSD-mastertCosmos-plus-OpenSSC Browse.
Choose file systermn: |default
Target Hardware
Hardware Platform: | OpenSSD2_hw_platform_o ~ || Mew

Processor: ps7_cortexad_0 ~

Target Software
Language: ®C (C++

05 Platform: standalone ~

Board Support Package: (@) Create New |GreedyFrL_b5p

Use existing

@ < Back Mext = Cancel

HANYANG

UNIVERSITY
ENC Lab 97

Embedded Network Computing Lab.



Select a Project Template

m Select an empty application and finish this template wizard

BB new Project O >
Templates )
Create one of the available templates to generate a fully-functioning @

application project.

Available Templates:

Peripheral Tests A blank C project.
Dhrystone
. e
Hello world
IwIP Echo Server
Memaory Tests
RSA Authentication App
SREC Bootloader
Kilkernel POSIX Threads Demo
Zyng DRAM tests
Zyng FSBL

@ Next > Finsh || cancel
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Add Source Code

m Copy GreedyFTL source files to “src” folder in project explorer

v Cosmos-plus-OpenS5D-master
w Frebuild
w Frebuild-3.0.0
GreedyFTL-2.5.0
GreedyFTL-2.6.0
v GreedyFTL-2.7.0
nvme
w Source
w Firmware
GreedyFTL-2.7.0
3 GreedyFTL-2.7 1
IPRepoc
W Fredefined_Project
w OpenssD2_2Ch8Way-1.0.0
OpenssD2.sdk
w Open5s502.srcs
constrs_1

sarsme

GreedyFTL-2.7.1

nvme

[ frmec_driver.c
frnc_driver h

[ init_ftl.c

init_ftl.h

B internal_req.h

[ low_level_scheduler.c
B low_|evel_scheduler.h
[} Iru_buffer.c

B |ru_buffer.h

| Iscript.ld

[£] main.c

i memory_map.h

[ page_map.c

ANYANG
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Co

[y Project Explorer 22 | B & | ¥ 7
v == GreedyFTL
4 Binaries
[ Includes
(7= Debug
(= SrC
v [ GreedyFTL_bsp
i BSP Documentation
= ps7_cortexad 0
[ & Makefile
[h, systerm.mss
(2 OpenSSD2_hw_platform_0

| e |
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Build Firmware (1/ 2)

m If everything goes well, the automatic build process should finish
successfully

ps7_afi_1 generic

ps7_afi_2 generic

ps7_afi_3 generic

ps7_coresight_comp_0 generic

ps7_ddr_0 generic

ps7_ddrc_0 generic
ps7_dev_cfg_0 devcfg Documentation |mport Examples
ps7_dma_ns dmaps Documentation |mport Examples
ps7_dma_s dmaps Documentation |mport Examples

€

» || Overview | Source |

4 19 = 8 ||[E problems | ¢ Tasks ' : '“'! %ITEEE:EH;'E!'F?':E
CDT Bui  [GreedyFTL] L o——

d LLTIATEAUL-BLL “WL, 71 "Wl e/ 2L/ LS0NLPLL LU “ho o f oo fJUNECUY T T L_ DS/ Py N AaT_ WS Lip Cu arreeu

# Finished building target: GreedyFTL.elf’

"Invoking: ARM Print Size'
arm-xilinx-eabi-size GreedyFTL.elf |tee "GreedyFTL.elf.size"

text data bss dec hex filename
1431e@ 3896 23836 1g9292 2954c GreedyFTL.elf
"Finished building: GreedyFTL.elf.size’

11: Build Finished (tock 2s5.733ms)
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Build Firmware (2 / 2)

m Click “Build All” to make both debug and release executables

HANYANG

UNIVERSITY
ENC

Embedded Network Computing Lab.

[(5 Project Explorer 32 l

|5 system hdf [l'm,

v [=5 GreeduFT
> # New
' Go Into

W

: Open in New Window
= Copy

Paste
¥ Delete

Source

Move...

Rename...

Import...
Export...

E. &

Build Project
Clean Project
Refresh

Close Project

vvvwvvvvyvyvvvyvy vy~ JRE

ﬁs’

Close Unrelated Projects

> & Build Configurations
= Make Targets

v @0 Index

Show in Remote Systems view

Convert To...

E

% Profiling Tools
g

C

Profile As

Ctrl+C
Ctrl+v
Delete

>

F2

FS

» Set Active »

GreedyFTL_bsp |

Modify this BSP's S

Target Information
This Board Support P

Hardware Specificati
Target Process

Operating System
Board Support Packa

MName: sta
Version: 4.2
Description: Stz
sut
Documentation:  sta

Peripheral Drivers

Drrivers present in the

“oller
sSC

o —
e —

Build All

afi
4
_afi

» Build Selected... afi

ps7_coresight_comp
ps7_ddr

ne7 Adrer

101



Building Firmware for Prebuild Bitstream

1. Create a workspace directory and a new application project
2. Set a hardware platform
3. Add source codes

4. Build firmware source codes
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Create a Workspace Directory

m Launch Xilinx SDK and designate the workspace

Select a workspace

Ailinx 50K stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,

Workspace: CM\Open550hProject' GreedyOpen3sD

[] Use this as the default and do not ask again
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Create a New Application Project

m Go to File -> New -> Application Project

HANYANG

UNIVERSITY
ENC Lab

Embedded Network Computing Lab.

B cic++ - xilinx SDK
File Edit Source Refactor

C. [

Mew

Open File...

Close
Close All
Save
Save As...
Save All
Revert
Move...
Rename. .
Refresh

Convert Line Delimiters To
Print...

Switch Workspace
Restart

Import...
Export...

Properties

Exit

Mavigate Search Project  Xilinx Tools Run  Window Help
Alt=Shift«N > (&) Application Project

Ctrl+W
Ctrl+Shift+W

Ctrl+5

Ctrl+5hift+5

F2

F5

Ctrl+P

Alt+Enter

Ed SPM Project
i, Board Support Package
T4 Project...
&% Source Folder
% Folder
[¢] Source File
[/ Header File
[ File from Template
-t Import
T Other.. Ctrl+N Import or
torials
Quick
=ting cheat sheets on View sho
features
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Import the Prebuild Bitstream from HDF (1 / 2)

m Press “New” to register the hardware description file (HDF)

B new Project O *

Application Project .
Project name must be specified @

Froject name: || |

Use default location
Location: | C:WOpenSSDWProjectWGreedyOpenSSD Browse...
Choosze file systern: [default
Target Hardware
Hardware Platform: | ZC702_hw_platform(pre-defined) w

Processor: ps7_cortexad_0 -

Target Software
Language: @®C OC++

05 Platform: standalone W

Board Support Package: @ Create New |

Use existing

® < Back Mext > Finish Cancel
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Import the Prebuild Bitstream from HDF (2 / 2)

m Name the hardware project and specify the path of the HDF

BB Mew Hardware Project

Mew Hardware Project

Create a new Hardware Project.

Project name: | Cosmos-plus-OpensSD-8C8W

Use default location
Location: | C:#0penSSDWProjectGreedyOpenSSDMCosmos-plus-OpenSSD-8C8W Browse..

Choose file systern: [default

Target Hardware Specification

Provide the path to the hardware specification file exported from Vivado.
This file usually resides in SDK/SDK_Export/hw felder relative to the Vivado project lecation.
The specification file and associated bitstream content will be copied into the workspace.

CACosmos-plus-OpensSD-mastertCosmos-plus-OpenSSD-mastersdPrebuildwPrebuild-3.0.08%0pensSD2-8C8W-Prebuild-3.0.0.hdf | | Browse..

@ coc
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Finish the Project Wizard

m Name the application project and finish this project wizard

@ MNew Project

Application Project

Create a managed make application project.

O X

=

w MNew Project

Templates

Create cne of the available templates to generate a fully-functioning
application project.

Project name: | GreedyFTL]

Use default location
Location: | C:WOpenSSDWProjectGreedyOpenSSD#GreedyFTL

Choose file systern: |default
Target Hardware
Hardware Platform: | Cosmoes-plus-OpensSD-8C8W

Processor: ps7_cortexad 0

Target Software
Language: ®C OCs=

QS Platform: standalone

Browse...

Board Support Package: (® Create New |GreedyFI’L_b5p

Use existing

Available Templates:

Peripheral Tests A blank C project.
Dhrystone
D (4
Hello World
[wIP Echo Server
Mernaory Tests
RSA Authentication App
SREC Bootloader
Xilkernel POSIX Threads Demo
Zynq DRAM tests
Zyng FSBL

@ < Back

@ < Back | Mext >d | Finish Cancel

MNext > Cancel
HANYANG
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Add Source Code

m Copy GreedyFTL source files to “src” folder in project explorer

w Cosmos-plus-OpenSsD-master
W Frebuild
W Frebuild-3.0.0
GreedyFTL-2.5.0
GreedyFTL-2.6.0
W GreedyFTL-2.7.0
nvme
w Source
w Firmware
GreedyFTL-2.7.0
GreedyFTL-2.7.1
IPRepc
W Fredefined_Project
w OpensSSD2_2Ch8Way-1.0.0
OpenssD2.sdk
w Open5502.srcs
constrs_1

GreedyFTL-2.7.0

Ve

[ frnc_driver.c
frnc_driver.h

[&) init_ftl.c

init_ftLh
internal_req.h

[ low_level scheduler.c
low_level scheduler.h
[2) Iru_buffer.c
Iru_buffer.h

| ] Iscript.ld

[ main.c
memory_map.h

[ page_map.c

(5 Project Explorer 52 | [ <}==5| ¥ T =0
i Cosmos-plus-OpensSSD-8C8W
w =% GreedyFTL
4 Binaries
it Includes

Co = Debug
& (= src

~ [l GreedyFTL_bsp
i BSP Documentation
= ps7_cortexad 0
| & Makefile
[k, systern.mss
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Build Firmware (1/ 2)

m If everything goes well, the automatic build process should finish
successfully

ps7_afi_1 generic

ps7_afi_2 generic

ps7_afi_3 generic

ps7_coresight_comp_0 generic

ps7_ddr_0 generic

ps7_ddrc_0 generic
ps7_dev_cfg_0 devcfg Documentation |mport Examples
ps7_dma_ns dmaps Documentation |mport Examples
ps7_dma_s dmaps Documentation |mport Examples

€

» || Overview | Source |

4 19 = 8 ||[E problems | ¢ Tasks ' : '“'! %ITEEE:EH;'E!'F?':E
CDT Bui  [GreedyFTL] L o——

d LLTIATEAUL-BLL “WL, 71 "Wl e/ 2L/ LS0NLPLL LU “ho o f oo fJUNECUY T T L_ DS/ Py N AaT_ WS Lip Cu arreeu

# Finished building target: GreedyFTL.elf’

"Invoking: ARM Print Size'
arm-xilinx-eabi-size GreedyFTL.elf |tee "GreedyFTL.elf.size"

text data bss dec hex filename
1431e@ 3896 23836 1g9292 2954c GreedyFTL.elf
"Finished building: GreedyFTL.elf.size’

11: Build Finished (tock 2s5.733ms)
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Build Firmware (2 / 2)

m Click “Build All” to make both debug and release executables

HANYANG

UNIVERSITY
ENC

Embedded Network Computing Lab.

[(5 Project Explorer 32 l

|5 system hdf [l'm,

v [=5 GreeduFT
> # New
' Go Into

W

: Open in New Window
= Copy

Paste
¥ Delete

Source

Move...

Rename...

Import...
Export...

E. &

Build Project
Clean Project
Refresh

Close Project

vvvwvvvvyvyvvvyvy vy~ JRE

ﬁs’

Close Unrelated Projects

> & Build Configurations
= Make Targets

v @0 Index

Show in Remote Systems view

Convert To...

E

% Profiling Tools
g

C

Profile As

Ctrl+C
Ctrl+v
Delete

>

F2

FS

» Set Active »

GreedyFTL_bsp |

Modify this BSP's S

Target Information
This Board Support P

Hardware Specificati
Target Process

Operating System
Board Support Packa

MName: sta
Version: 4.2
Description: Stz
sut
Documentation:  sta

Peripheral Drivers

Drrivers present in the

“oller
sSC

o —
e —

Build All

afi
4
_afi

» Build Selected... afi

ps7_coresight_comp
ps7_ddr

ne7 Adrer
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Preparing for Operating Cosmos+ OpenSSD |

1. Power on the platform board
2. Configure UART
3. Program FPGA

4. Execute firmware

HANYANG
UNIVERSITY
ENC Lab " 111



Power on the Platform Board

m Before you power on the board, make sure that your host computer is
powered off
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Configure UART

m In SDK, go to Terminal -> New Terminal Connection as shown below

¥ e Wv This Board Support Package is compiled to run on the following target.
nvme
i % fme driver c Hardware Specification: C:#OpenSSDWProjectWGreedyOpenSSDWCosmos-plus-OpenSSD-8C8Wwsystern. hdf
» [ fme driverh Target Processor: ps7_cortexad_0
> [ init_ftl.c .
- 0 ting Syst
5 [h] init_ftlh perating oystem
> [A] internal_req.h Board Suppoert Package 0OS.
5 [€] low_level_scheduler.c Mame: standalone
> [ low_level_scheduler.h Wersion: 4.2
> g Iru_buffer.c Descripticn:  Standalone is a simple, low-level seftware layer. It provides access to basic processor features
5[] Iru_buffer.h such as caches, interrupts and exceptions as well as the basic features of 3 hosted environment,
> [E mainc such as standard input and output, profiling, abort and exit.
s [# memory_map.h Documentation: standalone vd 2
5> [€ page_map.c
. [A page_map.h Peripheral Drivers
T Iscript.ld Drrivers present in the Board Support Package.
README.txt NVMeHostController_0 generic
v GreedyFTL_bsp _ TigerdNSC_0 generic
» 1 BSP Documentation TigeraMSC_1 generic
= ps?_cq-rtexag_ﬂ Tiger4NSC_2 generic
Lo Makefile Tiger4NSC_3 generic
[y, system.mss TigerdMSC_4 generic A
D\rerview‘ Source
[ problems | ¥ Tasks | Bl Console | 2 Properties | /2 Terminal 1 22 | &2 &7 B I3 BH| 2 ~ * 3 = 0 |ls
4§ Target Connections & - : | | | pe [é'j l = 6E| H_
4 Local [d ] Mo Cennection Selected Mew Tem'lTnaI Clonr'hacﬁon in Current View..
5 [= Auto Discovered Mew Terminal View

1

[y

No Connection Selected
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Configure UART

m Set “Connection Type” and “Baud Rate” to serial and 115200,
respectively

BB rew Terminal Connection x

View Settings:

Wiew Title: |Terrninal 1 |

Encoding: |1S0-8859-1 v]

Connection Type:

= >

Settings:

Port: COM1 ~
1@3'&?2 115200 “

Diata Bits: 8 ~

Stop Bits: 1 ~

Parity: Mone v

Flow Control: | None w

Timeout (sec): |
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Configure UART

m If then, UART is connected as shown below

fBTarg. | T O E;Prublem5|ElT35k5|E Cunsule|lf| Pruperties[@TerminaH B BEMERE @B = O
& 19 ||Serial: (COM1, 115200, 8, 1, None, None - CONNECTED) - Encuding: (ISD—SESQ—U'

-4 Local [default]
» = Auto Discoversd

Serial: (COM1, 115200, 8, 1, Mone, Mone - COMMECTED) - Enceding: {ISO-8859-1)
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Program FPGA (1/ 4)

m Click “Xilinx Tools” -> click “Program FPGA”

BR c/c++ - Xilinx SDK

File Edit Source Refactor Mavigate Search Project I}(ilinx Tools | Run Window Help

g - |®TQT@@E.E@1-@ Repositories
- W, Board Support Package Settings
5 Project Explorer &2 l = T Generate linker script
a [T cosmos_plus_8cBw
2 OpenSSD2_bd.tcl a2 _Program FPGA D‘;—l
B ps7_init_gple .H Program Flash
B ps7_init_gplh B Dump/Restore Data File
lg] ps7_init.c XMD Console
lg] ps7_inith B XSDE Console
@ ps7_inithtml 1 Launch Shell
= ps7_init.tcl B Create Zyng Boot Image
g system.hdf #t  System Generator Co-Debug Settings
4 |5 tutorial #t Configure JTAG Settings
b 4% Binaries
¢ @ Includes
¢ = Debug
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Program FPGA (2 / 4)

m Click “Program” to program FPGA

M Program FPGA

Program FPGA
Specify the bitstream and the ELF files that reside in BRAM memory

Hardware Configuration

Hardware Platform: ’cosmos_plus_BcBw vl
Connection: ’Local "H MNew ]
Device: Auto Detect

Bitstream: OpenSSD2.bit Search...| | Browse..

i

BMM,/MMI File: OpenSSD2.mmi Search...| | Browse..

Software Configuration
Processor ELF File to Initialize in Block RAM

< e | »

® L)) o]
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Program FPGA (3 / 4)

m Hang on a second

@ Configure FPGA with bitstream: ...If#cosmos_plus_Sc8witOpenSSD2.bit

— W

[ Cancel ] | Details > =
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Program FPGA (4 / 4)

m Check FPGA programming done successfully

| ~ 74~ = O ||ElSDK Log 5 | BRE- O
“ || B5:58:53 INFO : Launching XSDB server: xsdb.bat -s C:/Xilinx/SDK/2814.4/scripts/xsdb/xsdb/: «

B85:59:49 INFO  : Project 'cosmos plus 8cdw' created. You can now create BS5Ps and applicatio
@6:12:44 INFO I FPGA configured successfully with bitstream'“[:fuiuadu_pFujectfcusmus_plug

HANYANG
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Execute Firmware (1/ 3)

m Right click on the application project -> “Run As” -> click “1 Launch
on Hardware (GDB)”

Build Project
Clean Project
Refresh F5

Close Project

IfQ

Close Unrelated Projects

v Y Y Y YW

Build Configurations »
Make Targets »
Index r

o e o e e

a [ tutg Show in Remote Systems view
P Profiling Tools 4
P p Convert To...
Lo N Profile As v
i Debug As 4
Run As &£ 1 Launch on Hardware (GDB) [!
Team » 2 Local C/C++ Application
Compare With ¥ | & 3 Remote ARM Linux Application
Restore from Local History...

Run Configurations...

Create Boot Image ||

ED

rhanna Rafaranrad BEP T = = T = T—
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Execute Firmware (2 / 3)

m Click the firmware to execute -> click “OK” -> wait UART message

M Xilinx C/C++ Application E\

Choose Xilinx C/C++ Application

Binaries:

%+ tutorial.elf

Qualiier:

%5 armle - /tutorial/Debug/tutorial.elf

iarmle - /tutorial/Release/tutorial.el

o
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Execute Firmware (3 / 3)

m Press ‘n’ to maintain the bad block table

1

= EL Problems | ¥ Tasks | B Console | = Properties | & Terminal 1 &3

2115200 8.1 NﬂﬂgJMﬂﬂE.JZlNhEETED Encoding: (ISO-8¢
( ['] MMU has been enabled.

Hello COSMOS OpenSSD !!!

D Wait until FTL reset complete !!!

[ MAND device reset complete. ]

\ Press "X’ to re-make the bad block tahlg;/
\

HANYANG
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Bad Block Management (1 / 2) Q

Choose whether remake the bad block table in FTL initialization step

If you want to remake the bad block table, press “X” on UART terminal
- Bad block table format of greedy FTL v2.7.0 is different from the previous versions
- Damaged bad block table can be recovered

DS_SUB_REEXE Request 18 Fail - ch @ way 7 rowAddr 1 / status AS200001
,;7 [ bad block table of ch @ way 7 does not exist.]
[!] MMU has been enabled.
Hello COSMOS OpenSSD 1!
1D Wait until FTL reset complete 111
[ NAND device reset complete. ]
Press 'X' to re-make the bad block table.

[ bad block table of ch 1 way @ exists. ]

bad block: ch 1 Way @ Block 1169 (phyBlock 1169)
bad block: ch 1 Way @ Block 1175 (phyBlock 1175)
bad block: ch 1 Way @ Block 1481 (phyBlock 1481)

[ bad blocks of ch 1 way @ are checked. ]

HANYANG
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Bad Block Management (2 / 2)

Bad blocks are detected in FTL initialization step

Channel 0

Way 0

Bad Block Management

[ bad block table of ch 1 way @ exists. ]

bad block: ch 1 Way @ Block 1169 (phyBlock 1169)

Read a bad block table bad block: )

Update mapping data

]
5

Firmware \
Start i

FTL
Initialization

v

Host Request ;
Fetch

v

Host Request
Processing

Metadata Block
Bad Block Table

Way Y
Metadata Block

Bad block table
does not exist

T T I I I,

NC Lab

Embedded Network Computing Lab.

DS_SUB_REEXE Request 1@ Fail
bad block is detected: Ch
DS_SUB_REEXE Request 100 Fail
bad block is detected: Ch

6
ch 1 Way © Block 1175 (phyBlock 117
bad block: ch 1 Way @ Block 1481 (phyBlock 1481)
[ bad blocks of ch 1 way @ are checked. ]

“Block” number means mapped block number
“phyBlock” number means physical block number

DS_SUB_REEXE Request 18 Fail - ch @ way 7 rowAddr 1 / status AS800801
[ bad block table of ch 8 way 7 does not exist.]

Read a bad mark of all blocks
Distinguish bad block

R

ch @ way 7 rowAddr 56480 / status 1FFC3
Way 7 phyBlock 1380 (Block 1388)

ch @ way 7 rowAddr 81988 / status 1FFC3
Way 7 phyBlock 2873

i Save a bad block table
V/
[ bad block table of Ch B Way 7 is s

NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN NN EEEEEEENEEEEE



Turn on the Host PC

m Turn on the host PC when the firmware reset is done

| a
{2 Problems | ¥ Tasks | B Console | = Properties | & Terminal 1 &2

& 19 = O | serial: (COM3, 115200, 8, 1, None, None - CONNECTED) - Encoding: (ISO-8859-1)
' bad block: ch 7 Way 7 Block 7158 (phyBlock 7158)
bad block: ch 7 Way 7 Block 7505 (phyBlock 7585)
bad block: ch 7 Way 7 Block 7788 (phyBlock 7788)
bad block: ch 7 Way 7 Block 7995 (phyBlock 7995)
bad blocks of ch 7 way 7 are checked. ]
block erasure start. ]
entire block erasure completed. ]
storage capacity 976692 MB ]
map table reset complete. ]

FTL reset complete!!!
Turn on the host PC

JECTED) - Encoding: (ISO-8859-1)
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UART Messages While Host Computer is Booting

m NVMe SSD initialization steps are on going

| «

i Problems|£|Tasks|E Conso|e| = Properties[é,i' Terminal 1 & &7 L

Serial: (COM3, 115200, 8, 1, None, None - COMMECTED) - Enceding: (ISO-8859-1)
[ storage capacity 977588 MB ]
[ map table reset complete. ]

FTL reset complete!l!!
PCIe Link: 1

PCIe Bus Master: 1
PCIe Bus Master: @
PCIe Bus Master: 1
NVME CC.EN: 1

WVMe ready!!!
Done Admin Command OPC: 6
num_of_queue 38863

Set Feature FID:7

PCIe IRQ Disable: @

PCIe MSI Enable: 1, o0x@

Done Admin Command OPC: 9

create cq: Ox00000003, Ox0OFFEEB1
Done Admin Command OPC: 5

create sq: Ox00010005, ©xBOFFEEB1
Done Admin Command OPC: 1

Done Admin Command OPC:
Done Admin Command OPC:
Done Admin Command OPC:
Done Admin Command OPC:
Done Admin Command OPC:

o v v Ty O

(IS0O-8859-1)
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Operating Cosmos+ OpenSSD (Linux)

1. Check device recognition
2. Create a partition

3. Check the created partition
4. Format the partition

5. Create a mount point

6. Mount the partition

7. Check the mounted partition

HANYANG
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Open a Terminal (1 / 2)

m Click the pointed icon

Ubuntu Desktop

E
"
B
i

EA
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Open a Terminal (2 / 2)

Click the terminal icon

(C)

o=

Eii Applications

e

Terminal Thunderbird Mail

B Files & Folders

PNG

Screenshot from
...-01-11 15:39:28.png

mbedded Network Computing Lab. ::

Videos

Text Editor

Calculator

Filter results »

Rhythmbox Music
Player




Check Device Recognition (1 / 2)

Types “Ispci” -> press ENTER -> check “Non-Volatile memory controlle
r: Xilinx Corporation Device 7028” on the PCI device list

Terminal

]

enclab@enclab-desktop;: ~
enclabgenclab-desktop:

:00.8 Host bridge: I ation Xeon E3-1200 v2/3rd Gen Core processor DRAM Controller (rev 09)
PCI bridge: Intel Corporation Xeon E3-1200 v2/3rd Gen Core processor PCI Express Root Port (rev 09)
VGA compatible controller: Intel Corporation Xeon E3-1208 v2/3rd Gen Core processor Graphics Controller (rev @89)
USB controller: Intel Corporation 7 Series/C210 Series Chipset Family USB xHCI Host Controller (rev 04)
Communication controller: Intel Corporation 7 Series/C210 Series Chipset Family MEI Controller #1 (rev 04)
USB controller: Intel Corporation 7 Series/C210 Series Chipset Family USB Enhanced Host Controller #2 (rev 84)
Audio device: Intel Corporation 7 Series/C210 Series Chipset Family High Definition Audio Controller (rev 04)
PCI bridge: Intel Corporation 7 ries/C210 Series Chipset Family PCI Express Root Port 1 (rev c4)
PCI bridg Intel Corporation 7 ries/C210 Series Chipset Family PCI Express Root Port 5 (rev c4)
PCI bridge: Intel Corporation 7 Series/C21@ Series Chipset Family PCI Express Root Port 6 (rev c4)
PCI bridge: Intel Corporation 7 Series/C210 Series Chipset Family PCI Express Root Port 7 (rev c4)
PCI bridge: Intel Corporation 7 Series/C210 Series Chipset Family PCI Express Root Port 8 (rev c4)
USB controller: Intel Corporation 7 Series/C210 Series Chipset Family USB Enhanced Host Controller #1 (rev 84)
ISA bridge: Intel Corporation Z77 Express Chipset LPC Controller (rev 04)
SATA controller: Intel Corporation 7 Series/C210 Series Chipset Family 6-port SATA Controller [AHCI mode] (rev 04)
SMBus: Intel Corporation 7 Series/C210 Series Chipset Family SMBus Controller (rev 04)
PCI bridge: PLX Technology, Inc. Device 8749 (rev ca)
System peripheral: PLX Technolegy, Inc. Device 87d® (rev ca)

System peripheral: PLX Technology, Inc. Device 87d® (rev ca)
System peripheral: PLX Technolegy, Inc. Device 87d® (rev ca)
System peripheral: PLX Technology, Inc. Device 87d® (rev ca)
PCI bridge: PLX Technology, Inc. Device 8749 (rev ca)

olatile memory controll Corporation Devic
3 re Controller (rev 81)
SATA controller: ASMedia Technology Inc. ASM1062 Serial ATA Controller (rev 1)
Ethernet controller: Broadcom Corporation NetLink BCM57781 Gigabit Ethernet PCIe (rev 18)
USB controller: Etron Technology, Inc. EJ168 USB 3.0 Host Controller (rev 01)
PCI bridge: PLX Technology, Inc. PEX 8605 PCI Express 4-port Gen2 Switch (rev aa)
PCI bridge: PLX Technology, Inc. PEX 8605 PCI Express 4-port Gen2 Switch (rev aa)
PCI bridge: PLX Technology, Inc. PEX 8605 PCI Express 4-port Gen2 Switch (rev aa)
PCI bridge: PLX Technology, Inc. PEX 8605 PCI Express 4-port Gen2 Switch (rev aa)
PCI bridge: ASMedia Technology Inc. ASM1083/1085 PCle to PCI Bridge (rev 03)
FireWire (IEEE 1394): VIA Technologies, Inc. VT6306/7/8 [Fire II(M)] IEEE 1394 OHCI Controller (rev c@)
enclabg@enclab-desktop:~$
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Check Device Recognition (2 / 2)

Types “Is /dev” -> press ENTER -> check “nvmeOnxxxx” on the device
list

Terminal

enclab@enclab-desktop: ~

enclab@enclab-desktop:~$
autofs fw2 oopU rams ttyi1

block hidrawo loop1 random ttyiz
bsg hidrawl  loop2 rfkill ttyil3
btrfs-control hidraw2 loop3 rtc ttyi4d
bus hpet loop4d rtco ttyls
char hwrng loop5s sda ttyis
console i2c-0 Loop6 sdal ttyl7
core i2c-1 loop7 sdaz ttyis
Cpu i2c-2 loop-control sda5s ttyi9
cpu_dma_latency 1i2c-3 mapper sgb tty2

cuse i2c-4 mcelog shm tty20
disk i2c-5 meio snapshot tty21
dri i2c-6 mem snd tty2z
ecryptfs i2c-7 memory_bandwidth stderr tty23
fbo i2c-8 net stdin tty24
fd input network_latency stdout tty2s
full kmsg network_throughput tty tty26
fuse kvm null ttyo tty27
Two lightnvm _Dimel ttyl tty2s
ful ttyle  tty29

enclab@enclab-desktop:~§ I

DEDDD O 6 @
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Create a Partition \N

Type “sudo fdisk /devinvmeOnxxxx”, press ENTER -> type your passw
ord, press ENTER -> type “n”, press ENTER -> type “p”, press ENTER
-> type “1”, press ENTER -> type “4096”, press ENTER

Terminal

F-

enclab@enclab-desktop: ~

enclab@enclab-desktop:~$ |sudo fdisk /dev/nvme®n250262528
[sudo

Note: sector size 1s 4096 (not 512,

Device contains neither a valid DOS partition table, nor Sun, SGI or OSF
Building a new DOS disklabel with disk identifier @xfdd4e2ze.

Changes will remain in memory only, until you decide to write them.
After that, of course, the previous content won't be recoverable.

Warning: invalid flag @x0000 of partition table 4 will be corrected by w(

Command (m for help):[:]
Partition type:
p primary (@ primary, © extended, 4 free)
e extended
select (default p):
Partition number (1-9, default 1_}:
First sector (256-250262527, default 256_}:
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Check the Created Partition

m Types “Is Idev” -> press ENTER -> check “nvmeOnxxxxpl” on the devi
ce list

Terminal

enclab@enclab-desktop: ~

enclab@enclab-desktop:~$

autofs hidrawi o0op4 ramoe sdaz ttyé ttyszo usb

b hidraw2 loop5s raml sdas ttyeo ttysz1 userio
b hpet loop6 ramlo sg0h ttye1l ttysz22 vcs
btrfs-control hwrng loop7 ramil shm ttye2 ttysz23 vcsl
bus i2c-0 loop-control ramiz snapshot ttye3 ttysz4 vcs2
char i2c-1 mapper rami3s snd tty7 ttys2s vcs3
console i2c-2 mcelog rami4 stderr ttys ttys26 vcsd
core i2c-3 meid ramis stdin ttys ttysa27 vcs5
Ccpu i2c-4 mem ramz2 stdout ttyprintk ttyszs vcsb
cpu_dma_latency 1i2c-5 memory_bandwidth ram3 tty ttysoe ttys29 vcsa
cuse i2c-6 net ram4 ttyo ttysi ttys3 vcsal
disk i2c-7 network_latency rams ttyl ttysio ttys3o vcsaz
dri i2c-8 network_throughput ramé ttylo ttysii ttys3i vcsa3l
ecryptfs input null ram7 ttyl1 ttysiz ttys4 vcsad
fbo kmsg nvme0d rams ttylz ttysi3 ttyss vcsas
fd kvm pumefn2 5028 : ram9 ttyl3 ttysisg ttyse vcsab
full lightnvm random ttyi4 ttysis ttys7  vfio
fuse por rfkill ttyis ttysie ttyss vga_arbiter
wo loop0d PPP rtc ttylé6 ttysi7 ttyso vhci
fwl loopl psaux rtcoe ttyl7 ttysis uhid vhost-net
fw2 loop2 ptmx sda ttyis ttysi19 uinput zero
hidrawd loop3 pts sdal tty19 ttys2 urandom
enclab@enclab-desktop:~$ I

=
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Format the Partition

Type “mkfs -t ext4 /| dev/invmeOnxxxxp1”, press ENTER

Terminal

mbedded Network Computing Lab.

enclab@enclab-desktop: ~

enclab@enclab-desktop:~5sudo mkfs -t ext4 /dev/nvmedn250262528pil

mke2fs 1.42.9 (4-Feb-2014)
Filesystem label=
0S5 type: Linux
Block size=4896 (log=2)
Fragment size=4096 (log=2)
Stride=0 blocks, Stripe width=0 blocks
62570496 inodes, 250258432 blocks
12512921 blocks (5.00%) reserved for the super user
First data block=6
Maximum filesystem blocks=4294967296
7638 block groups
32768 blocks per group, 32768 fragments per group
8192 inodes per group
Superblock backups stored on blocks:
32768, 98304, 163840, 229376, 294912, 819200, 884736, 1
|

4096000, 7962624, 11239424, 20480000, 23887872, 71663616,

102400000, 214990848

Allocating group tables: done

Writing inode tables: done

Creating journal (32768 blocks): done

Writing superblocks and filesystem accounting information: done

enclab@enclab-desktop:~5% I
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Create a Mount Point

m Type “sudo mkdir /media/nvme”, press ENTER

Terminal

6 X enclab@enclab-desktop: ~

enclab@enclab-desktop:~9 sudo mkdir
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Mount the Partition

m Type “sudo mount /dev/invmeOnxxxxpl /media/nvme”, press ENTER

Terminal

g 0 enclab@enclab-desktop: ~
Mx? enclabgenclab-desktop:~$

enclab@enclab-desktop:~
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Check the Mounted Partition (1 / 2)

m Type “Isblk”, press ENTER -> check the mounted partition on the bloc
k device list

Terminal

enclab@enclab-desktop: ~

enclab@enclab-desktop:~$ lsblk
NAME MIN RM TYPE MOUNTPOINT
sda : G| 1. disk

:0
sdal :1 0 1. part [
sda2 12 part
:5
)
1

disk
part fmedia/nvme

nvmedn250262528 259:
L—numeﬂnEEGEﬁESEEpl 259:
enclab@enclab-desktop:~5%

3]
0 . part
3]
3]

NYANG
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Check the Mounted Partition (2 / 2)

Type “df -h”, press ENTER -> check the mounted partition on the stora
ge list

Terminal

enclab@enclab-desktop: ~

enclab@enclab-desktop:~$ df -h

Filesystem Size Used Avail Use% Mounted on
udev 3.86 8.8K 3.8G 1% [dewv

tmpfs 769M 1.3M 767M 1% frun

fdev/sdal 1.8T 4.4G 1.7T7 1% /

none 4.0K 4.0K 0% /sys/fs/cgroup
none 5.0M 5.8M 8% /run/lock

none 3.860 3.8G 1% /run/shm

HANYANG
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Operating Cosmos+ OpenSSD (Windows)

1. Check device recognition
2. Create a partition

3. Format the partition

139



Check Device Recognition (1/ 3)

m This PC — click left mouse button — click “Properties”

@ Manage
Pin to Start

Map network drive...

Disconnect network drive...

Create shortcut
Delete

Rename

Properties

HANYANG
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Check Device Recognition (2 / 3)

m System — click “Device Manager”

i System

4 B » Control Panel » All Control Panel ltems » System

Control Panel Home . . . .
View basic information about your computer

@ Device Manager Windows edition
.@I Remote settings Windows 8.1 Pro
® System protection @ 2013 Microsoft Corporation. All rights reserved. I
@J Advanced system settings Get more features with a new edition of Windows
System
Proceszon Intel(R} Core(Th]) i5-4670 CPU @ :
Installed memory (RAM): 2,00 GB
System type: £4-bit Operating Systern, x64-base
Pen and Touch: Mo Pen or Touch Input is available

Computer name, domain, and workgroup settings

Computer name: TestPC
Full cormputer name: TestPC
HANYANG
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Check Device Recognition (3 / 3)

m Disk drives — double-click “NVMe Cosmos+ OpenSSD”

Device Manager

=

File Action View Help

L ANl NENR 7 Rl Y
4 g TestPC

[+ ij Audie inputs and ocutputs
i+ (M Computer

F | MES
l = MVMe Cosmos+ OpenS50 '
W

g S120000MO0T-1CH164
i UFDBM T7 38AD USE Device
[ l;'," Display adapters
f i Firmware
[ % Hurnan Interface Devices
I g IDE ATASATAPI controllers
[» <= Keyboards

[» ﬂ Mice and other pointing devices
- B Monitors

B @ Metwork adapters

4 |[f5 Other devices

NVMe Cosmos+ OpenS5D Propel

It PCl Simple Communications Controlle

Iml Cal A a~ v "

HANYANG
UNIVERSITY
ENGLab .

General | Paolicies | Wolumes | Drriver | Details I E\re.-rrts|

. NYMe Cosmos+ Open55D
S
Device type: Disk drives
Manufacturer: (Standard disk drives)
Location: Bus Mumber 0, Tanget 1d 0, L
Device status

[This device is working propery.
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Create a Partition (1/5)

m Control panel — click “Administrative Tools”

HANYANG

UNIVERSITY
ENC Lab

Embedded Network Computing Lab.

All Control Panel ltems =

H + Control Panel » All Control Panel ltems »

mputer's settings

_enter

ial Manager

vianager

Access Center

ayer (32-bit)

roup

Add features to Windows

¥ 8.1

“@ BitLocker Drive Encryption
7 o Date and Time
.gbﬁ Devices and Printers

% Family Safety

Folder Options

q% Indexing Options

v & Search Control Panel

View by: Largeicons ¥

5 :1 . . .
Administrative Tools

R e

Configure administrative settings for
your computer.

Color Ma

@ Default Programs

!' Display

| 29 File History

h Fonts

L .
¢—| Internet Options
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Create a Partition (2 / 5)

m Administrative tools — double-click “Computer Management”

Shortcut Tools Administrat

Share View Manage

b Control Panel ¢ All Control Panel lterns  » Administrative Tools

e

Mame Date modified T

»

T e I L L
e = —

= r@ Computer Management 2013-08-22 2= 3.
1CES s m
[, Disk Cleanup 2013-08-22 2= 3., Si
@ Event Viewer 2013-08-22 2% 3., &I
@_ iSCSI Initiator 2013-08-22 2= 3., &I
@ Local Security Policy 2013-08-22 2= 3., Si
QDBC Data Sources (32-bit) 2013-08-222H &... Sl
ODBC Data Sources (B4-bit) 2013-08-22 2= 3., I
@ Perfarmance Monitor 2013-08-22 2% 3., SI
@ Print Management 2013-08-2 2= 3., Si
@ Resource Monitor 2013-08-22 2% 3., &I
|'5ujp} Services 2013-08-2 2= 3. Si
R
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Create a Partition (3 / 5)

m Computer management — click “Disk Management” — click “OK” to
confirm disk initialization

.ﬁ' Computer Management

File Action View Help

«o|zE  E R B

;g_l Computer Management (Lecal|| Volume | Layoutl Type I File System | Status
a [?3 System Tools =] Simple Basic Healthy (Recovery Partition)
B @ Task Scheduler =] Simple Basic Healthy (EFI System Partition)
i+ fd] Event Viewer -] Simple Basic Healthy (Primary Partition)
i+ G| Shared Folders (=] Simple Basic Healthy (Primary Partition)
> %. Local Users and Groups| <= (C:) Simple Basic NTFS Healthy (Boot, Page File, Crash Dump, Primary
S Perfarmance o (D) Simnle Rasic NTES Healthy (Primar: Partitinnl
g Device Manager == Vindows_2.1 Initialize Disk “

R You must inttialize a disk before Logical Disk Manager can access it.
=f Disk Management

b

Use the following partition style for the selected disks:

£
(") MBER {Master Boot Record) L
iDisk 0 (@ GPT (GUID Partition Table)
181395|1c2 GB Note: The GPT partition style is not recognized by all previous versions of
y Windows.
Online
Cance

4 Disk 1 |

Basic (D2

18A3.07 GR 18A2 N1 AR MTES
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Create a Partition (4 / 5)

m Click right mouse button on “Disk 2” which was shown in 3" step —

click “Properties”

HANYANG
UNIV

NIVERSITY

Embedded Network Computing Lab.

e Cnune
= Device Manager
4 =] Storage

=F Disk Management

» D Services and Applications

== Windows_8.1 (E:) Simple Basic FAT32

Healthy (Active, Primary Partition)

<
CiDisk 1 ]
Basic (D)
1863.02 GB 1863.01 GB NTFS
Online Healthy (Primary Partition)
CiDisk 2 —
Basic -
1022.96 GB Igew Spanned Volume...
Online Mew Striped Valume...

ew Mirrared Volume... |
= Disk 3 MNew RAID-5 Velume... _
Removable P
15.13 GB Convert to Dynamic Disk...
Online Convert to MBR. Disk

Unallecat
_ Offline
l Properties
Help
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Create a Partition (5/5)

m Make sure that the “Disk 2” is Cosmos+ OpenSSD before you proceed
to the next step

Y Computer Management - 0
File Action View Help

|
;{' Computer Management (Local | Valume I Layoutl Typel File Systeml Status I C | Actions
4 m System Tools (=] Simple Basic Healthy (Recovery Partition) 3 : o~
[ @ Task Scheduler (=] Simple Basic Healthy (EF| System Partition) i Bisighdapagement
- {&] Event Viewer [=] : u 3 Mare Actions 13
b &) Shared Folders = NVMe Cosmos+ OpenSSD Properties 7l
== (C) Partition) 7
i k Local Users and Groups o) General | Policies | Volumes | Driver | Details | Events i 1
i (%) Performance o Lk 4
- '
) Device Manager <= Windows 8.1 ¢ _ NVMe Cosmos+ OpenSSD E
4 2 storage =
=f Disk Management
[ i; Services and Applications Device type: Disk drives
Manufacturer: (Standard disk drives)
Location: Bus Number 0, Target Id 0, LUN O
Device status
< This device is working propery. N
—
~
= Disk 1
Basic
1863.02 GB
Online
== Disk 2
Basic
1022.96 GB
Online
Cancel
==Disk 3
Removable indows_8.1 (E)
1513 GB 15,13 GB FAT32
Online Healthy (Active, Primary Partition) v

M Unallocated W Primary partition

A
v
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Format the Partition (1 / 8)

m Click right mouse button on the right part of “Disk 2” — click “New
Simple Volume”

A& Computer Management = =
File Action View Help
|
;&- Computer Management (Local | Volume I Layoutl Type | File System | Status I C | Actions
a [} System Tools [=] Simple Basic Healthy (Recovery Partition) 3 : -
4 @ Task Scheduler = Simple Basic Healthy (EFI System Partition) il Disk Management
> @ Event Viewer (=] Simple Basic Healthy (Primary Partition) 3 More Actions »
> ]| Shared Folders (=] Simple Basic Healthy (Primary Partition) 7.
5 k Local Users and Groups || = () Simple Basic NTFS Healthy (Boot, Page File, Crash Dump, Primary Partition) 7
N @ Performance ca (De) Simple Basic NTFS Healthy (Primary Partition) H
& Device Manager == \\indows_3.1(E) Simple Basic FAT32 Healthy (Active, Primary Partition) 1
4 5 Storage

=% Disk Management
> :j(j Services and Applications

P >
iDisk 1 ________
Basic (D:)

1863.02 GB 1863.01 GB NTFS
Online Healthy (Primary Partition)

uDisk 2 |

Basic
1022.96 GB
N 1022.96 GB | Mew Simple Velume... |
Online Unallocated
Mew Spanned Volume...
T —
== Disk 3 E Mew Mirrored Volume..,
Removable Windows_8.1 (E) R
15.1.3 GB 15.13 GB FAT32 Mew RAID-5 Volume...
Online Healthy (Active. Priman, ] Y
< > || W Unallocated Wl Primary partition Properties
Help
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Format the Partition (2 / 8)

m Click “Next”

& Computer Management = =
File Action View Help
| | B
;{u Computer Management (Local|| Velume I Layoutl Typel File System | Status I C | Actions
a m Systern Tools [=] Simple Basic Healthy (Recovery Partition) 3 - -
[ ® Task Scheduler [=] Simple Basic Healthy (EFI Systemn Partition) n Disk Management
i+ [ Event Viewer =] Simple Rasic Healthy (P Partitinn] kS More Actions »
i+ @ Shared Folders = New Simple Volume Wizard “ 7
i & Local Users and Groups|| = ( ition) 7
b @ Performance S (@ Welcome to the New Simple b
i Device Manager =W Volume Wizard b

a 23 Storage
=¢ Disk Management
3 _-ﬂ_q Services and Applications

This wizard helps you create a simple volume on a disk.

A simple volume can only be on a single disk.

To continue, click Next

Basi
1863
Onli

=i
Basi
1023
Online Eﬂallocated

< Back Next = Cancel

== Disk 3
Removable Windows_8.1 (E)

15.13 GB 13.13 GB FAT32

Online Healthy (Active. Primary Partition) v
< > || M Unallocated Wl Primary partition

HANYANG

UNIVERSITY
ENC Lab 149

Embedded Network Computing Lab.



Format the Partition (3 / 8)

m Click “Next”

& Computer Management = B
File Action View Help
| e [
& Computer Management (Local | Volume | Layoutl Typel File System | Status | C | Actions
4 [f} System Tools =] Simple Basic Healthy (Recovery Partition) H
[ Task Scheduler (=] Simple Basic Healthy (EFI System Partition) 1 Disk Management
B Event Viewer =] Simnle_Rasic Healthy (Primare Partition] 3 More Actions
» @] Shared Folders = New Simple Volume Wizard “ 7
¢ 3 Local Users and Groups| [ ( ition) 7
3 @ Performance S (0 Specify Volume Size 1
é Device Manager - Choose a volume size that is between the maxdmum and minimum sizes. 1!
4 E Storage
= Disk Management
3 fg} Services and Applications
Maximum disk space in MB: 1047506
Minimum disk space in MB: 63
Simple volume size in MB:
< >
S|
A
=
Basi
1863
Onl
==
- <Back || Ned> | Cance
1024
Online Unallocated
==Disk 3
Removable Windows_8.1 (E)
13.13GB 13.13 GB FAT32
Online Healthy (Active, Primary Partition) &

W Unallocated Wl Primary partition

HANYANG
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Format the Partition (4 / 8)

m Select desired drive letter — Click “Next”

HANYANG

UNIVERSITY
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-
File Action View Help

L s

Computer Management

Eil Computer Management (Local
4 m System Tools
3 @ Task Scheduler
2] Event Viewer
©» | Shared Folders
i % Local Users and Groups
I @ Performance
=) Device Manager
a4 & Storage
= Disk Management
3 f»‘g Services and Applications

Volume I Layout I Type I File System I Status I C
=] Simple Basic Healthy (Recovery Partition) 3
=] Simple Basic Healthy (EFI System Partition) il
(=] Simnle__Rasic Healthw (Primary Partition 3
=] Mew Simple Volume Wizard “ 7
[=N( ition) 7
= ([ Assign Drive Letter or Path 1
- Far easier access, you can assign a drive letter or drive path to your partition. 1!

() Mourt in the following empty NTFS falder: ——
Browse...
< () Do not assign a drive letter or drive path >
—
~
=i
Basi
1863
Onl
=1i
- <Back || New> =
1022
Online Unallocated
= Disk 3
Removable Windows_8.1 (E)
1513 GB 15.13 GB FAT32
Online Healthy (Active, Primary Partition) ke

W Unallocated [l Primary partition

Actions

Disk Management
More Actions

-
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Format the Partition (5 / 8)

m Type desired volume label — Click “Next”

Computer Management = =
Eil ‘[?éomputer Management (Local I Layoutl Type I File System | Status I C | Actions
4 Systermn Tools =] Simple Basic Healthy (Recovery Partition) 3 - -
[ @ Task Scheduler (=] Simple Basic Healthy (EFI System Partition) il BislMapagement
[+ E Event Viewer (=" Simnle_Rasic Healthw (Primary Partitionl 3 Maore Actions
I ] Shared Folders =] New Simple Volume Wizard “ 7.
3 %—l Local Users and Groups ||~ { ition) 7
b @ Performance [="}{I Format Partition ) - ) 1
é Device Manager - To store data on this partition, you must format it first. 1!
4 E Storage
(=% Disk Management Choose whether you want to format this volume, and if so, what settings you want to use.

3 fj¢ Services and Applications
(") Do not format this volume

(®) Format this volume with the following settings:

File system: NTFS Y]

< Allocation unit size: . . >
S
=)
Basi Perform a quick form:
1863
onl [ Enable file and folder compression
=]
- <Back M| Net> [§| Cancel
1024
Online Unallocated

== Disk 3

Removable Windows_8.1 (E)

15.13 GB 15.13 GB FAT32

Online Healthy (Active, Primary Partition) Y
< > || W Unallocated B Primary partition

HANYANG
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Format the Partition (6 / 8)

m Click “Finish”

& Computer Management = B
File Action View Help
Lo s
;§. Computer Management (Local | Volume I Layoutl Type I File Systeml Status I C | Actions
a [} System Tools (=] Simple Basic Healthy (Recovery Partition) 3 - -
3 @ Task Scheduler = Simple Basic Healthy (EFI System Partition) il Biskiidapagemank
[ g Event Viewer (=] Simnle Rasic Healthw (Primary Partitinn 3 More Actions 3
1 G| Shared Folders = New Simple Volume Wizard “ 7
1 &l Local Users and Groups| | < ( ition) 7
» (R Performance o Completing the New Simple 1
&} Device Manager =W Volume Wizard 1
a4 3 Storage
i=¥ Disk Management *You have successfully completed the New Simple Volume
I T Services and Applications Wizard
You selected the following settings:
Wolume type: Simple Volume ~
Disk selected: Disk 2
Volume size: 1047506 MB
Drive letter or path: F:
File system: NTFS
< Alocation unit size: Defautt >
Volume label: New Volume - J
Ouiirle frmat- Yas Py
(=)
Basi To close this wizard, click Finish.
186
Onli
(=]
1024
Online @nallocated
= Disk 3
Removable Windows_8.1 (E)
15.13 GB 15.13 GB FAT32
Online Healthy (&ctive, Primary Partition) v
< > || l Unallocated Bl Primary partition

HANYANG
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Format the Partition (7 / 8)

m Formatting is now finished

A Computer Management = B
File  Action View Help
| = X =&
;EJ Computer Management (Local|| Volume I Layoutl Type I File System I Status I C | Actions
a '['[’é System Tools (=] Simple Basic Healthy (Recovery Partition) 3t - -
3 @ Task Scheduler = Simple Basic Healthy (EFl System Partition) il Bisiihapaacment
1+ §2] Event Viewer (=] Simple Basic Healthy (Primary Partition) 3 Mare Actions L4
I+ gal Shared Folders (=1 Simple Basic Healthy (Primary Partition) 7
S %J Local Users and Groups|[=# (C:) Simple Basic NTFS Healthy (Boot, Page File, Crash Dump, Primary Partition) 7
b @ Performance = (D) Simple Basic NTFS Healthy (Primary Partition) 1
‘é Device Manager CwMew Volume (R} Simple Basic NTFS Healthy (Primary Partition) i
. E Storage == \Windows_8.1 (E) Simple Basic FAT3Z Healthy (Active, Primary Partition) 1
=4 Disk Management
I» qu Services and Applications
< >
'
~
“iDisk 1
Basic (D)
186_3.02 GB 1863.01 GB NTFS
Online Healthy (Primary Partition)
New Volume (F)
1022.96 GB NTFS -
Healthy (Primary Partition)
==Disk 3
Removable Windows_8.1 (E)
1313 GB 15.13 GB FAT32
Online Healthy (Active, Primary Partition) hd
< > || B Unallocated B Primary partition
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Format the Partition (8 / 8)

m Now you can find the formatted Cosmos+ OpenSSD at “This PC”

LANRA Drive Tools This PC
Computer View Manage
1 M ThisPC » v
S Favorites 4 Folders (6)
B Desktop
& Downloads h Desktop {& Docurnents
“El Recent places o
8 This pPC h Downloads D Music
€ Network h Pictures . Videos
4 Devices and drives (3)
== Local Disk (C:) Local Disk (D)
= I W
53.5 GB free of 77.6 GBE ‘5;;/ 1.81TBfreeof 1.81T
Mew Volume (F:)
S 0.99 78 free o 099 T8
HANYANG
UNIVERSITY
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=) New Volume (F:) Properties “
| Security I ReadyBoost I GQuota I Customize
General | Tools | Hardwars | Sharing
(___"_3, | New Volume
Type: Local Disk
File system:  NTFS
. Used space: 222 760,960 bytes 212 MB
. Free space: 1,098.166.886 400 bytes 055 TB
Capacity: 1.098,389,647 360 bytes 095 TB
—
] Compress this drive to save disk space
[#] Allow files on this drive to have contents indexed in addition to
file properties
OK || Canesl | fpely




Evaluating Cosmos+ OpenSSD Performance

1.

Install benchmark application (lometer)

Disconnect workers except one worker

Generate a access specification

Set the sufficient number of outstanding I/Os

Assign a access specification

Run an evaluation

Check evaluation results

HANYANG
UNIVERSITY
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Install Benchmark Application

m lometer 1.1.0 (http://www.iometer.org/doc/downloads.html)

» Cosmos+ OpenSSD is recognized as NVMe storage device
o lometer = =

=8| = SE=| ~le|& o158 ¢ |

Topelogy Disk Targets § Network Targetsl Access Specificationsl Results Displayl Test Setup
B Al Managers pleiss

- IKwWAK2 g C —Maximum Disk Size

O Velume{974c3167-20d2-1126-825 I{} Sectors
[l(j 1: "NWMe Cosmos+ OpenS5D T‘r’Pl

— Starting Disk Sector
I{}

—# of Outstanding /05
|1 per target

— Use Fixed Seed

r I Fixed Seed Value

— Test Connection Rate

il I 3 Transactions per connection

—Write 1O Data Pattern
IRepeating bytes j

A

HANYANG
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http://www.iometer.org/doc/downloads.html

Disconnect workers except one worker

m Avoid Workers having a same access specifications

» Workers can access the same logical address almost the same time
- Increase the data buffer hit ratio

» Performance can be measured higher than real performance
lo] lometer - |:|
#|a| === e8] > [aE]w] 2]

Topology Disk Targets | Network Targets | Access Specification® Results Display | Test Setup
E)ﬂ\ Al M anagers ~Targets
= KAk oo ~Maximum Disk Size
i KAl 0 C Volume(974¢3167-20d2-1126-825 Io cectors
it bl D& 1: "NVMe Cosmos+ OpenSSD TYPE
L warker 4 — Starting Disk Sector

IO
—# of Qutstanding 1/0s
|1 per target

— Use Fixed Seed

r I Fixed Seed Value

— Test Connection Rate

I I 3: Transactions per connection

— Write |0 Data Pattern
IRepeating bytes j

| 4
HANYANG
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Generate a access specification

m User can define a access specification
lo lometer - oI IE8
= B CLIE,

Topology Disk Targets' Metworl Targets Results Display' Test Setup
= Rﬂ\ 2]l Managers Assigned Access Specifications———— Global Access Specifications
- Swkwiak2 iz Idle
2 worker 1 % Default
#5512 B; 100% Read; 0% random
32512 B; 75% Read; 0% random

E

Edit Acce: Sbeciﬁcation

O ——
-Mame Default Assignment
128KE Sequential Wiite |7| MHone LI
= Size | XAc:c:ess| Xﬂead| XHandoml Delay | Burst| Alignment | Feply | Insert Before |
OKiE 128KE OB 100 a a a 1 OMiE 4KB 0B hiome
Rerr
Inzert After |
Delete |
Move Up . - Transfer Request Size——————— — Percert of Access Specification -F'erlcent ReadMwrite Digtiibution
o = [ o o = J L
. 100% 0%
Megabpte:  Kilobytes Bytes 100 Percent Write Read
- Percent Random/Sequential Distribution — Burstine: —align |/0z on
JI Transfer Delay Burst Length " Request Size Boundarie:
1003 3 ’VID ms—‘ [|1 1403 " Sector Boundaries
Sequential R andom o |IJ ﬁ |4 ﬁ ID j
Megabytes  Kilobytes Bytes
—Reply Size
& Mo FReply
o o= = =
H A N YA N G Megabytes  Kilobytes Butes ok I Cancel |
UNIVERSITY
ENC Lab
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Assign a access specification

m Select a desired access specification and click “Add” button
o] lometer = =

=\e| Y02 4o o[ 9wE] ¢

Topology Disk Targetg,l Metwork Targets Access Specifications | Results Display' Test Setup
Ezﬂ\ &l Managers —Assigned Access Specifications —Global Access Specifications

B JwKwaK2 [ > 128KB Sequential Write | %1 16 KIB; 100% Read; 0% random Mew |

L worker 1 4216 KiB; 75% Read; 0% random
: 4216 KiB; 50% Read; 0% random Edit |

A 2216 KiB; 25% Read; 0% random
““ 41216 KiB; 0% Read; 0% random Edit Copy |

2 32 KiB; 100% Read; 0% random

5,732 KiB; 75% Read; 0% random Delete |

".,. %7 32 KiB; 50% Read; 0% random

T, 31232 KiB: 25% Read: 0% random

41732 KiB; 0% Read; 0% random
5,5 64 KiB; 100% Read; 0% random
Remole == | 517 64 KIB; 50% Read; 0% random

2 3¢ 64 KiB; 0% Read; 0% random

E 412 256 KiB; 100% Read; 0% randor
312 256 KiB; 50% Read; 0% random
3¢ 256 KiB; 0%t Read; 0% random
22 All in one
128KB Sequential Write

q
2 4KB Random Write
:24KB Random Read
Maowe Up howe Down < >

128KB Sequential Write y:

HANYANG
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D o

Set the Sufficient Number of Outstanding I/Os

m X channel - Y way flash array needs “X * Y” outstanding flash requests
at least for utilizing multi channel/way parallelism

In case of a Cosmos+ OpenSSD configuration (8 channel — 8 way, 16KB page size),
“128KB sequential write” access specification needs 8 outstanding 1/Os at least

4

64 (128KB/16KB * 8) outstanding flash requests
Recommend the environment generating 2 * X * Y outstanding flash requests

lo] lometer - O
2 g @l = ;
||| =S| A S | 4B
Topology Metwork Targets ] Access Specifications ] Results Display ] Test Setup
Eﬂ\ &ll Managers Targets
- ka2 o9 c Maximum Disk Size
- Worker 1 0 3 Volume{974c3167-20d2-11e6-825 | g R

lzf==11: "NVMe Cosmos+ OpenS5D TYPY

Starting Disk Sector
C.
# of Outstanding 1/0s

16 per target
Use Fixed Seed

- Fixed Seed Value

Test Connection Rate

- EI Transactions per connection

Write IO Data Pattern
|Repeating bytes j

|
|
| >
|
HANYANG ‘
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Run an Evaluation

m Set the update frequency and click “Run” button
lometer = =
rirlEllllalml%II Elﬁlﬁ‘-lﬂﬁ I

Topology Disk Targets | Network Targetsq Access Specificaticns | Results Display § Test Setup
= ﬂ tanagers ~Results Since - Update Frequency (seconds)
E- Sk 2 Drag managers and workers I
« Start of Test
----- 3 Worker 1 from the Topology window [~ ﬁiﬁ'{g tljs;(t”:pdate I_ I
to the progress bar of your chaice. ¢ Last Update

~ Display
All Managers 0.00

Total I/Os per Second

All Managers 0.00 MBPS (0.00 MIBPS)

g
Total MBs per second (Decimal) | | gs
J
2]
s
g

All Managers 0.0000

Average |/0 Response Time (ms)

All Managers 0.0000

Maximum /0 Response Time (ms) |

All Managers 0.00 %

% CPU Utilization (total)

All Managers 0

Total Error Count

y
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Check evaluation results

m “Results display” tab shows the performance evaluation results

« |IOPs, throughput, average/maximum response time
o] lometer = =

w | =HCDE| Ae|8] o2k N 7]

Topalogy Disk Targets | Metwork Targets | Access Specifications Results Display |Test Setup
E/ﬂ\ All M anagers Results Since Update Frequency (seconds)
B JwikwaK2 Drag managers and workers record lact update :
- Worker 1 from the Topology window - Its to fi i : |1 vI
to the progress bar of your choice. [ESULSILOIIE " Last Update
— Display
All Managers 9538.96 10000
alvosperseond | | -

All Managers 125029 MBPS (119237 MIBPS) 10000
Total MBs per Second (Decimal) | - j

13.3981 100

All Managers
Average 1/0 Response Time (ms) | - j
All Managers 153729 100
Maximum I/C Respanse Time (ms) | - j

All Managers 2.94 % 10 %
2 CPU Utilization (total) | ] j

All Managers 0 0
Total Error Count | | j

[Run 1 of 1 )
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Evaluation Guideline \N

Perform pre-fill process before the read performance evaluation
There are no mapping information for unwritten data

Set the number of outstanding I/Os equal or less than 256
Unknown problem of host interface

Set the write request size equal or larger than the page size

Read-modify-write process can degrade the performance
- In case of “4KB random write”, IOPs can be decreased as the experiment progresses

HANYANG
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Evaluation Results (1 / 3)

m Maximum throughput/channel = 173 MB/s
» 100Mhz DDR flash bus (bit width: 8) — 200MB/s
» 16,384 + 1,664(spare) byte page — 90% (16,384/18048) of 200MB/s = 181MB/s
» Overhead of flash memory controller — 173 MB/s

m Measured throughput/channel of 8channel-8way configuration
» Sequential read: 99% of maximum throughput
» Sequential write: 45~90% of maximum throughput

1600 (MB/S) 1400MBI/S)
1400 |8 SLC 1200 Bl SLC
B vLC B MLC
1200 1000
1000 800
800
00 600
400 400
200 200
0 - 0 -
Q) Q) Q) Q) Q) B Q) > > > > Q) Q) Q)
T e o o oY Nty Y e o o oY
128KB sequential read 128KB sequential write
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Evaluation Results (2 / 3)

m Maximum 4KB IOPs/channel = 10812 IOPs

Page mapping — a page is accessed in order to access 4KB data
173MB/s(Maximum throughput/channel) + 16KB (page size) = 10812 IOPs

m Measured throughput/channel

1channel-8way configuration
- Random 4KB read: 96% of maximum 4KB IOPs
- Random 4KB write: 38~88% of maximum 4KB I0Ps
8channel-8way configuration
- SW-based scheduling has a larger latency in many channel/way configuration
- Scheduling latency can increase the idle time of hardware controllers

80000(1OPS) s 70000('OP; e
70000 -—- i
T e 60000 |~ gy
60000 50000
o
30000 30000
20000 20000
10000 10000
0 - 0 -
\@* q}@ w@ %&* %4@ Qy* Qy* \@* q}@ w@* %4@ %$q$ @@ %$®\
HANYANG & & & ’L& b@? Cb& & & & & q/c‘? bg‘f‘ cb(‘f‘
UNIVERSITY 4KB random read 4KB random write 166
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Evaluation Results (3 / 3) { ‘

m Performance degradation by on-demand garbage collection
After all available blocks are used, garbage collection is triggered steadily

Effect of performance degradation varies depending on copy operation overhead
- Copy operation overhead depends on the number of valid page belong to victim blocks

(MBIs) (MB/s)

1260 1400
1250 1200 L—‘—O—‘-‘—’—Q \

\'
Y
1240 - 1000 \
\ \ \ -67.4%
1230 ‘\ 800 8
\ -36% X
1220 \ 600 \ ¥
1210 Y 400
1200 \\./M 200
1190 T T T T T 1 O T T T T T 1
0 5 10 15 20 25 30 0 5 10 15 20 25 30
Victim blocks with no valid pages Victim blocks with valid pages (half of total page)
in SLC 8channel-8way configuration in SLC 8channel-8way configuration
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Thank You




